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CHAPTER 1 INTRODUCTION 

1.1 GENERAL  

FTS Forest Technology Systems Ltd StreamTrac is a data collection software package that automatically or 

manually retrieves data from a network of FTS remote monitoring stations and then stores the collected data in 

a central database for analysis and modification.  StreamTrac software displays turbidity, stage, sediment, and 

discharge data in both a tabular and graphical format.  It also allows users to modify the data by adjusting the 

lines and points on a graph while maintaining the original data points, or simply editing the fields of a table. 

StreamTrac software brings together a wide array of functions and tools for an unprecedented level of flexibility 

and power in weather data processing.  

StreamTrac uses the FTS AutoCaller calling service to ensure timely data retrieval.  AutoCaller dynamically 

handles simultaneous station calls and is capable of collecting data via multiple modem, Internet, and direct 

data logger connections.  A centralized Open Database Connectivity (ODBC) compliant database eliminates the 

need for users to individually collect data, thus minimizing station calling charges.  Once the calling schedule for 

a remote monitoring station or group of stations is defined, AutoCaller will autonomously (no login required) 

poll the stations at the predetermined time to retrieve the latest data available and then save this data into the 

central database. 

Figure 1-1:  StreamTrac System Components 

 

StreamTrac  
Application 

StreamTrac  
ODBC Database 

AutoCaller  
Calling Service  

 
            COM Port                                                                                     Internet 
  Modems or Direct Connect                 GSNet, GOES, Digital Cellular, Ubicom 
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Further details of the StreamTrac system components and its applications can be found in the StreamTrac 

Overview and Quick Start Guide. 

The StreamTrac system user interface, known as the StreamTrac application, is a Windows application.  It does 

not require a Station License and may be installed on multiple computers.  StreamTrac will allow the creation of 

any number of stations; however; automatic station data collection by the AutoCaller Calling Service will be 

limited to the number of licensed stations.  

The main menus of StreamTrac are outlined after the installation instructions with the relevant details for each 

menu provided in subsequent chapters. 
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1.2 INSTALLATION INSTRUCTIONS 

System Requirements 

 

• Computer running Windows 2000, XP, Vista, or Windows 7. 

• Microsoft .NET 2.0 or higher. 

• 4 gigabyte (GB) of RAM minimum. 

• A 1024 x 768 or greater resolution display. 

• 60 gigabytes (GB) of hard disk space. 

• SQL Server 2000 / 2005 / 2008, or Server 2012 if SQL option is used. 

• High-speed Internet connection if IP modems are used. 

 

 

NOTE:  You must have administrative rights on the PC to install the software 

 

 

 

1) Double click the file 

StreamTrac_XX.XX*.msi 

to run it and follow the steps on-screen. All 

of your data and settings will be preserved 

from your previous StreamTrac version. 

 

*XX.XX will be replaced with the version number 

currently being installed 

 

 

 

 

 

NOTE:  If you have installed a previous version of StreamTrac that used the MSI installer, you will be 

prompted to remove the previous version first.  Removing the application will not remove your 

MDB files, or your INI files.  Also, if you have version 2.5.2.1 or a version prior to that, your MDB files 

and INI files will not be overwritten by the new MSI installer. 

If you do not MS .NET 2.0 or higher installed, you will not see the Welcome screen. 
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2) You must accept the License Agreement to 

proceed with the installation 

 

 

 

 

 

 

3) Choose the directory in which you want to 

install the application.  Do not change the 

name of the FTS folder. 

 

 

 

 

 

 

 

4) The Typical installation will install only the 

StreamTrac application. To select specific 

services to install, along with the 

StreamTrac application, click the Custom 

button.   
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5) If doing a Custom installation, choose the 

items you wish to install. 

 

 

NOTE:   In a multi-user environment, where multiple users will be connecting to a common database, the 

AutoCaller service should be installed on only one of the computers that connects to that database. 

 

 

 

6) After Step 5, you have the option to specify 

the ‘Log On As’ credentials that any 

Services to be installed will use when the 

computer starts up (the default is ‘Local 

System’.) (Optionally, you can run 

‘services.msc’ from the Start Menu after the 

installation and change the ‘Log On As’ 

credentials then.) 

 

 
 

 

7) After you have chosen the type of 

installation click Install to proceed with the 

installation. 
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8) Click Finish to complete the installation. 

 

 

 

 

1.2.1 Modifying the Installation or Removing the Application 

At any time you can run the installer again to modify your installation.   

 

NOTE:  “Remove” will remove all of the installation files; however, database files (.mdb 

files) and settings files (.ini) will not be removed.  If StreamTrac is later installed on the 

same PC, all data and settings will still be available. 
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1.3 HOME PAGE 

The home page displays a map view which is a geographical representation of the location of defined stations.  

Use the drop down menu to select which map program to be used.  Use scale slider bar to manipulate map scale 

or use the mouse’s scroll button.  Use the mouse to left click, hold and drag to pan the map.  The database which 

StreamTrac is interacting with is displayed in the bottom left-hand corner of the screen 

Defined stations will appear as location pins and station information will be displayed by hovering the mouse 

over the pin.  A red location pin indicates a station whose data is stale (failed to have been collected within the 

assigned Failure Hours), whereas a green location pin indicates a station whose data is current.  Stations can be 

selected by clicking on the marker or using the drop down menu at the bottom left corner of the page.  The map 

will automatically pan to the defined station selected from the drop down menu when the Go To Station 

button is pressed.  Defined Groups can be located and viewed by selecting the desired groups using the Group 

Filters button. 

 

Figure 1-2:  Home Page 

1.4 MAIN MENUS 

The StreamTrac home page consists of 7 main menu headings: File, Stations, Data, Graph, Site Visits, Settings, 

and Help.  Chapter Two will briefly describe the main tabs.  Each tab will be described in detail in their individual 

chapters.   

 

  

Defined Station 
(“Demo”) 

Map Program in use Defined  Stations 

Group 
Filters 
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CHAPTER 2 MAIN MENUS 

2.1 FILE 

 

2.2 STATIONS 

The submenus under the Stations menu are used to 

configure the StreamTrac system for proper station 

calling (see Figure 2-2).  Users can define the remote 

monitoring stations or modify existing stations.  

Options include: Station Setup for defining individual 

stations, Group Setup for defining the station groups, 

and Utilities to upload UbiCom software. 

 
Figure 2-2:  Admin Application Stations Menu 

2.2.1 Station Setup  

The Station Setup option is used to define a station in the StreamTrac system.  Through this menu, stations can 

be added to or deleted from the database, have their telemetry details defined (how to call), have calculations 

formulated, have the Datalogger program viewed or edited, have their automated calling schedule defined 

(when to call), and have station details and notes recorded. 

Refer to Chapter 3 STATIONS> Station Setup Menu for more details on station configuration.  

2.2.2 Group Setup 

The Group Setup option is used to define a Station Group in the StreamTrac system.  Through this menu, 

Station Groups can be created or deleted from the database.  Stations can then be added into one or several 

groups and each group can have its automated calling schedule defined. 

Refer to Chapter 3 STATIONS> Group Setup Menu for more details on station group configuration.  

2.2.3 Utilities 

The Utilities option is used to upload UbiCom software for those stations using UbiCom to communicate.   

Refer to Chapter 3 STATIONS> Utilities for more details on uploading Ubicom software. 

 

 

The File menu is a basic drop down menu which 

permits the user to close StreamTrac by selecting Exit.  

StreamTrac can also be closed by selecting the X in 

the upper right hand corner of the screen. 

 

 

Figure 2-1:  File Menu 
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2.3 DATA 

 

The Data menu allows the user to manually initiate 

station or group calls, monitor calls (both manual and 

scheduled), and view results from diagnostic calls.  

The user can also view the data from a selected station 

and import, export and transfer data. 

 

 
Figure 2-3:  Data Menu 

2.3.1 Collect Data and Telemetry Calls 

The Collect Data & Telemetry Calls option is used to initiate manual calls. Through this option the user can 

choose what information to retrieve or send (data, diagnostic information, send/receive datalogger program, set 

time) and whether to call an individual station or a station group.  Manual data collection can be used to get 

‘current conditions’ at a station or to backfill missing data whereas diagnostic information can be used for 

network troubleshooting. 

Refer to Chapter 4 DATA> Collect Data & Telemetry Calls Menu for more details on retrieving data.  

2.3.2 Show Call Status 

The Show Call Status option opens the Call Status window which is used to monitor all call activity to the 

stations in the database.  Recent manual calls from the Admin Application and automatic scheduled calls from 

the Calling Service are displayed in the Current Status tab of the Call Status window while the History tab is used 

to filter and view the status of past calls. 

Refer to Chapter 4 DATA> Show Call Status Menu section of the manual for more call status details.  

2.3.3 View/Edit  

The DATA> VIEW/EDIT menu option opens the currently-selected database and displays stored data for a particular 

station in a tabular format.  The data screen allows the user to select a station and then customize the screen to 

display and print only specific data fields within a specific time range.  Multiple customized data screens can be 

opened within the Admin Application.   

Refer to Chapter 4 DATA> View/Edit Data Menu for more details on viewing data.  

2.3.4 Show Info Calls  

The Show Info Calls option opens the Information Call Results window which is used to display information 

returned by manual calls initiated within the Admin Application.  The information shown on the Information Call 

Results window is generally diagnostic information and is not saved in the StreamTrac Database.  With a 

manual data call, the Information Call Results window will indicate what data was written to the database (the 

retrieved station data will not be displayed in the Information Call Results window).   

Refer to Chapter 4 DATA> Show Info Call Menu for more call status details.   
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2.3.5 Import 

The DATA > IMPORT option allows the importation of data into StreamTrac’s records from different source formats. 

StreamTrac supports both CSV (comma separated variable) and Campbell (Campbell Scientific).  

To import data it is necessary to create a template which contains information on what fields are to be imported 

and how the import is to be done. 

Refer to the DATA> Import Menu section of the manual for more details on importing data.   

2.3.6 Export 

The  DATA > EXPORT   option will allow you to export your station or group of stations to CSV or XML 

files.  Furthermore, these exports can be performed on an un-attended scheduled basis using the 

FTS Exporter service 

Refer to Chapter 4 DATA> Export Menu for more details on exporting data.  

2.3.7 Data Transfer 

The DATA>DATA TRANSFER option will allow you to create self-contained compacted files which 

contain one or more stations. These files can then be sent to other StreamTrac users and the data 

from these fields can then be integrated into the target user’s database.  

Refer to Chapter 4 DATA> Data Transfer for more details on creating and using data transfer files. 

2.3.8 Data Alarms 

The Data Alarms interface allows you to create and view trigger conditions and manage contacts for alarms 

generated by the trigger conditions. However, The Data Alarm service must be installed for alarms to be 

functional. 

Refer to Chapter 4 DATA> Data Alarms for more details on creating and editing alarms. 

2.3.9 Dashboards 

The Dashboard screen feature will provide up to the minute weather information on the selected stations. As 

data is collected the dashboard will automatically update the selected data fields as well as update the chosen 

fields on the graph. The dashboard is designed to report on a single station, however, the line graph section will 

allow you to plot multiple stations on a single dashboard for comparison purposes. 

 

Refer to Chapter 4 DATA> Dashboards for more details on developing dashboards. 

2.3.10 View Audit Log 

The DATA > VIEW AUDIT LOG option will allow you review events and changes to one or several stations.  The date 

range, source, field and actions to be displayed can be customized.   

Refer to Chapter 4 DATA> View Audit Log for more details on setting up and viewing an audit log. 

2.3.11 Get/Set Data by Tag Name 

The  DATA > GET/SET DATA BY TAG NAME option will allow you to retrieve current variable values for  selected data 
and set values (when permitted) for selected variables. 
 
Refer to Chapter 4  DATA> Get/Set Data by Tag Name  for more details 

 



StreamTrac  

700-ST-MAN  Rev. 2 -  29 Oct 2015  Page 11/155 

2.4 GRAPH 

 

The Graph menu is used to produce graphs from the data.  Two types of graphs can be produced: Time Series 

and Wind Roses.   

 

 

Graphing data allows visual comparison of different data fields as well as comparing data from different stations.  

Additionally, graph data can be edited visual with the graphing interface while the original data is preserved.  

The graphing module contains many editing features.  Some examples are gap filling, data shifting and point by 

point dragging/editing. 

 

 

 

 
Figure 2-4:  Graph Menu 

 

2.4.1 Existing Graphs 

The GRAPH>EXISTING GRAPHS menu displays a list of all existing graphs.  From this menu, selected graphs can be 

viewed.  Filters can be selected to view graphs be the creator, last saved user, last saved date, and graph type. 

 

Selected graphs can also be edited and deleted from this menu. 

 

Refer to Chapter 5 GRAPH>Existing Graphs for more details on how to create and manipulate graphs.  

 

2.4.2 Open Blank Graphs 

The GRAPH>OPEN BLANK GRAPHS menu is used to create a graph template for a Time Series Graph or a Wind Rose 

graph. 

 

Refer to Chapter 5 GRAPH>Open Blank Graphs section for more details on how to create graph templates. 
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2.5 SITE VISITS 

 

The Site Visits menu is used to issue and view Site Visit reports. 

 

 

 
Figure 2-5:  Site Visits 

2.5.1 Issue New Site Visit 

The  SITE VISIT>ISSUE NEW SITE VISIT  menu displays a page with a variety of tabs to record bottle mapping, site 

details, calibration samples and any notes or attachments relevant to the visit/station. 

Refer to Chapter 6  SITE VISITS>Issue New Site Visit for more details on completing  a site visit report.  

2.5.2  View All New Site Visits 

The SITE VISIT>VIEW ALL SITE VISITS  menu opens a Site Visits page which allows you to select which visit reports to 

view by date, station(s) name or site visit number.    

Refer to Chapter 6 SITE VISITS>View All Site Visits for more details on viewing site visit reports. 

 

 

2.6 SETTINGS 

The SETTINGS menu provides the user with the ability to connect to an alternate database and customize the 

account by adding/deleting accounts, selecting a language, and determining file storage and display formats. 

 

 
Figure 2-6:  Settings  
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2.6.1 Switch Database 

The SWITCH DATABASE menu is intended to be used to select between a local database and the main 

StreamTrac Database when running StreamTrac on a Remote User Computer. 

The Switch Database option opens a Windows browsing dialog box to allow the user to connect the StreamTrac 

Application to an alternate database.  This option enables a user on a Remote User Computer to switch between 

monitoring the main StreamTrac Database and a local database.  The local database could be used for manual 

test calling of non-permanent stations (stations which you do not want to appear in main StreamTrac 

Database).    

 

IMPORTANT!  If the user connects the StreamTrac Application to a different database 

and the StreamTrac Application is running on the same computer as the Calling 

Service, then the Calling Service will also use the newly selected database.   

Refer to the DATA> Switch Database Menu section of the manual for more details on database selection.  

2.6.2 User Accounts 

The User Accounts option shows all the user accounts and can be used to add, delete, or edit the user accounts. 

Refer to Chapter 7 SETTINGS MENU> User Accounts for more details on editing the user accounts. 

2.6.3 Language  

The Language option opens a drop down menu from which English, Spanish, or Chinese can be selected as the 

user interface language.  Note that a language pack must be installed for language selection other than the 

language in use by the computer to be fully functional.  

2.6.4 Global Settings  

The Global Settings option shows Overall System Settings consisting of the File Storage Path with a Browse 

option.  The user can also select the preferred Date and Time Display Formats.  There is also an Outgoing Alarm 

Mail Settings section for the user to configure the data alarm service.  

Refer to Chapter 7 SETTINGS > Global Settings Menu for more details on applying settings and file storage options. 

2.6.5 Compact Database 

If your StreamTrac is connected to a Microsoft Access database (.MDB) you may need to occasionally compact 

your database. Clicking this option presents you with a confirmation warning and then will begin this process   

 

IMPORTANT!   Make sure that the AutoCaller service, data alarm service and the FTS 

Importer/exporter service is stopped and that no remote users are actively connected 

to your database prior to performing this operation. 



StreamTrac  

700-ST-MAN  Rev. 2 -  29 Oct 2015  Page 14/155 

2.6.6 Edit Colours 

The Edit Colours option permits you to edit the colours which indicate the status of the data as it appears in the 
Data>Edit/View screen.   Clicking on a particular colour category will display a Color chart which can be used to 
customize the colour selections. 
 
Refer to Chapter 4 DATA>View/Edit for more details 

 

2.7 HELP 

The Help menu allows the user access to an online user manual and access to version number, serial number, 

and license information about the StreamTrac system. 

 

 
Figure 2-7:  Help Menu 

2.7.1 User Manual 

The HELP> HELP FILES menu option opens a PDF copy of the StreamTrac User Manual and other reference 

documents.   

2.7.2 About 

The HELP> ABOUT menu option opens the About window which displays version number, serial number, and 

license information about the StreamTrac system.  Also, the Add StreamTrac Service Licenses button on the 

About window is used to activate or change the number of stations that the Calling Service is automatically able 

to call by entering an appropriate license key.   

Refer to Chapter 8 HELP> About Menu for more details on the help menu and on station license modification.  
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CHAPTER 3 STATIONS MENU 

3.1 MODIFY/ADD STATION 

Users can define their remote monitoring stations or modify existing stations through the STATIONS> STATION 

SETUP menu.  The name of the currently selected station is displayed in the Station Name drop-down menu 

selection box.  All stations that have been configured in the StreamTrac Database will appear in this Station 

Name drop-down list.   

The Navigate Through Stations buttons on the bottom of this window provide the ability to single-step 

forward and backward through the station list.  Individual station details can be changed by using the seven 

configuration tabs located below the Station Name.  These tabs are discussed in detail in the following section. 

 

  
Figure 3-1:  Stations> Station Setup Menu 

 

3.1.1 New Station 

To Add a New Station to the StreamTrac Database, click the New Station button then enter a name for the new 

station.  If you require Turbidity Threshold Sampling (TTS) related fields for the station, check the checkbox and 

the corresponding fields will be automatically added. 

 

Configuration Tabs 
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Figure 3-2: Adding a Station 

The new Station Name will be displayed in the Description tab, and the blank field cans be filled in. After a 

station has been added, other station details can be input using the configuration tabs.  Once named, a station 

cannot be renamed due to the internal configuration of the database.  Be sure to check the Show on Maps 

checkbox if you want the station to appear on the Map View. 

 

3.1.2 Copy Station 

To copy a station from the StreamTrac Database, navigate to the station you wish to copy and then press the 

Copy Station button.  You will then be presented with a dialog box from which you can enter the new station 

name as well as choose whether to copy Telemetry, Schedule and/or the station Data. 

 
Figure 3-3: Copy Station 

 

3.1.3 Delete Station 

To delete a station from the StreamTrac Database, navigate to the station you wish to delete and then press the 

Delete Station button.  As a precaution you will be prompted to confirm the deletion before the station is 

removed from the database as the Delete Station button removes all station information from the database.  

Historical station data is not available once the station has been deleted. 
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3.2 DESCRIPTION TAB 

 

The Description configuration tab details the specifics of the remote station data logger.  If desired, enter the 

serial number of the data logger to enable serial number checking of the data being retrieved.  A time offset 

which is applied to the retrieved data before the data is saved in the database may also be entered.  Once data 

has been collected from the station, the names of the data fields being collected in the data logger are displayed 

in the Field name box.  The user can then add notes or comments to each of the various field names. 

 
Figure 3-4: Station>Station Setup>Description Tab 

3.2.1 Serial Number 

The Data Logger Serial # box is a feature designed to ensure that data being saved to the database is being 

collected from the correct data logger (i.e., eliminate the possibility of having incorrect telemetry information 

like a wrong phone number).  The functionality of this feature is as follows:  

1) If the Data Logger Serial # box is left blank then the serial number checking is ignored and 

all data collected from the logger is saved into the database; 

2) If a serial number has been entered, then all data collected from the logger is checked to 

ensure that the serial number of the collected data matches the reference serial number 

entered in the Data Logger Serial # box. If the serial numbers match then the data is saved.   

If there is a serial number mismatch then: 

 if the call was placed manually through the Admin Application, the user is 

prompted whether or not to save or discard the collected data; or 

 if the call was placed automatically by the Calling Service, then the data will be 

automatically discarded. 

In both of the above scenarios, when data is saved, the serial number of the data logger will always be saved in 

the StnLoggerSN (Station Logger Serial Number) field in the database along with the data.  This allows the user 

to track which data logger supplied the data. 
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IMPORTANT!   If serial number checking is enabled and the station datalogger is 

subsequently replaced, the serial number of the newly installed datalogger must be 

entered before station data from the new datalogger will be saved to the database. 

 

3.2.2 Data Time Offset 

The Data Time Offset box allows the user to enter a time offset that will be applied to the data collected from a 

remote station before the data is saved in the database.  The feature is intended to allow the remote station to 

operate on a time reference different than that of the StreamTrac Database.  For example, on a remote station 

equipped with GOES telemetry (an FTS G5/G6 Transmitter) the data logger is synchronized to UTC time via the 

transmitter’s GPS reference while the data in the database can be referenced to the user’s local time.  Some 

typical Data Time Offset values are shown below. 

 

Remote Data logger 

Time  

StreamTrac Database 

Time 
Data Time Offset Value 

UTC PST -8:00 hours 

UTC MST -7:00 hours 

UTC CST -6:00 hours 

UTC EST -5:00 hours 

 

3.2.3 Coordinates 

The Coordinates box provides fields to enter the station’s latitude and longitude, and elevation and elevation 

units.  South latitudes and West longitudes must be prefaced with a minus symbol.  If the Station is connected to 

a GOES transmitter which is operating with GPS, these values will be entered automatically. 

Show on Maps: For the station to appear on the Map View, ensure the checkbox is checked.   

Failure Hours: Indicates the time beyond which, if no data is collected, the station’s location marker will turn red, 

indicating a possible problem with the station.  Hours can be input using decimals (ie: 1.25 hours for one 

hour and 15 minutes). 

 

3.2.4 Field Names 

The Field Names display box will contain the names of the data fields being used in the data logger. 

 

3.2.5 Field Units 

Selecting a data field in the Field Name box will display the units of measurement being used. Units for user-

defined fields can be manually entered.  Field units will be displayed on the Data>View/Edit screen in the 

column headings under the appropriate Field Name. 
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3.2.6 Field Hints 

Notes or comments for each of the data fields displayed in the Field Names box can be entered here.  The 

entered comments will appear on the Data>View/Edit screen when the cursor hovers over the Field Name 

heading. 

To enter a hint for a particular field:  

1) select the field name for which you wish to enter a hint (once selected the field name 

will be highlighted in blue); and 

2) enter the desired information in the Field Hints box. 

3.2.7 Add Field 

The Add Field control allows a new field to be added to the station’s database.  Enter the desired name.  

Reserved names or those already in use will be rejected ensuring no corruption of data occurs.  Select the 

Numeric or Text radio buttons as appropriate to reflect which form the data will be input into the new field.  The 

added field can be used by another application which acts on the StreamTrac Database.   

Field names, whether Numeric or Text, must start with a letter or underscore symbol (_).   

 

 
Figure 3-5: Add New Station Field 

3.2.8 Delete Field 

The Delete Field control is used to delete a field from the station’s database.  Note that deleting a field will also 

cause the data for that field to be deleted from the database.  If the deleted field is a field used by the data 

logger, then the next time data is retrieved from the data logger, the field will reappear in the Field Names list; 

however, the data previously collected for that field will remain deleted and only newly collected data will 

appear in the database. 

 

 

IMPORTANT!  Deleting a field with data in it will erase all of that data permanently! 
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3.3 COMMUNICATION TAB 

 

The Communication configuration tab is used to enter the specifics of each telemetry device connected to the 

remote station data logger.  Through this configuration tab, communication methods can be added, modified, 

or deleted.  A communication method is a defined way of contacting a remote station using a specific computer 

and its attached devices (i.e. COM ports, modems etc.) and a specific remote telemetry device (i.e. direct 

connection or telephone modem, radio modem, satellite modem, etc.).  Multiple communication methods may 

be defined for a remote station. 

 

 
Figure 3-6:  Station Setup Menu> Communication Tab 

Often there is more than one way to contact a remote station, so a station may have multiple communication 

methods.  For example: 

1) a station may have more than one telemetry device; or  

2) the station may have a single telemetry device which has more than one mode of 

operation; or 

3) there may be several Remote User Computers, in addition to the Calling Service 

Computer, which manually collect data from the remote stations (each Remote User 

Computer would normally require its own communication method).  

Each of the above examples would have their own communication method defined as a Site Specific 

Communication Method.  

Although there can be several communication methods defined for one station, there can only be one default 

communication method (Default checkbox selected). The default communication method is used by the Calling 

Service to automatically call the station when the station is called as part of a station group.   

The example in Figure 3-6 shows that the station has two communication types: GOESTelem and FTS.  The 

GOESTelem (named LRGS) is checked as the default communication method. 
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3.3.1 Add/Modify Communication Method 

Communication methods may be added, modified, or deleted by clicking the Add/Modify Communication 

Method button (or by right-clicking in the communication methods white space) and then selecting the desired 

action (Add New, Modify, or Delete).   

A communication method is deleted by highlighting it (selecting it) then clicking on the Delete button or right 

clicking and selecting Delete Communication Method.  When deleting a communication method, the user is 

prompted for confirmation before the action is carried out 

There are four types of communication methods which can be added: FTS, GOESTelem, GSNet, and Ubicom 

(Figure 3-7).   

To add a communication method, select the desired method.  You will be prompted to give the method a 

descriptive name.  This is the name that will appear in the list of communication method choices for manual or 

scheduled calls.  A good practice is to begin the name of the communication method with the name of the 

computer on which the communication method can be used (e.g., “MyComputerName – Telephone Modem”). 

This allows remote users to easily identify the communication method which was defined for use with their 

computer and modem. 

To modify a communication method, highlight the desired method and then select “Modify Communication 

Method”.  This will bring up the setup page which can then be edited. After completing the required alterations, 

click the OK button to save the changes and close the communication method. 

 

 
Figure 3-7: Communication Types 

A detailed explanation of setting up each of the different communication methods follows.  
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3.3.2 Communication Type - FTS 

The FTS Telemetry type encompasses all connections to the data logger in which the data logger immediately 

replies to an incoming data request.  Telemetry information is stored in a database, which can be local or remote, 

so it can be accessed by any computer which is connected to the database.   

 

FTS Telemetry supports the following connections to the remote data logger (see Figure 3-8):  

 direct cable connections;  

 Phone Modem: FTS TM, and FTS TM Ultra, FTS GS4000 and IP (internet protocol) Modem  

 Radio Modem:  

 

 
Figure 3-8: FTS Telemetry Setup 

Description:  Displays the descriptive name given to the communication type when it was added.  

Data Logger: Use the drop down menu to select the type of datalogger used by the station.  If the datalogger 

has a password, enter it here so that the data can be accessed.  The Use Saved Sensor Sets should be 

checked in order to limit the amount of information being transmitted.  By checking this, the sensor sets are 

only sent once, and subsequent transmissions will consist of only data. 

Telemetry: There are three Telemetry options: Direct Connection, Phone Modem, and Radio Modem.  When one 

is selected, the associated fields will be unlocked and able to be input with the necessary information.  All 

three require the Allowed Com Ports, Baud Rate and Wakeup Delay fields to be populated.   
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 1) Choose Allowed Com Ports:  select the Com ports which can be used for the communication  

  method.  Only active ones will be able to be selected.  To activate a COM port, select the Global 

  Computer Setup button (see Serial Port Setup section below). 

 

 2) Baud Rate:   The baud rate required for the chosen telemetry configuration is usually   

  automatically set; however, the Baud Rate drop-down menu may be used to override the  

  default selection.  

 3) Wakeup Delay:  this is the time interval allowed for the station to respond to a query  

  originating from StreamTrac.  The default setting is 300ms but it can be manually changed;  

 

Direct Connection:  select this when there are direct cable connections between the Calling Service and the 

Station. 

Phone Modem:  Select the Modem Type from the drop down menu and input the telephone number.  Valid 

telephone number characters are numbers (0-9), brackets (for readability ie: area codes), and commas (dial 

pause operator for getting outside line). Do not use dashes or spaces. 

  Telephone number example:   9,1(555)1239875 

 

Radio Modem:  Select the Radio Modem type from the Add RM drop down menu (bottom of screen) and follow 

the prompts.  You can also edit the RM address from this area.   

 

Once the radio modem Telemetry Path has been defined, select the Enable Telemetry Devices. 

 

 

WARNING!  Failure to Enable Telemetry Devices will result in the Radio Modem not functioning. 

 

 Serial Port Setup 3.3.2.1

In order to establish communications with remote sites, the individual computer which is being used to call the 

site must have its communication ports configured.  This is done using the Serial Port Setup menu which is 

opened by selecting the Global Computer Setup button. 

 

 

Global Computer Setup button 
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Figure 3-9:  Serial Port Setup Screen Example 

To add a communications port select an Active checkbox on a blank field (the Com # will initially be red 

indicating that it is inactive.  Once checked it will turn green, indicating that it is active).  Left click on the blank 

Modem field to bring up the drop down menu of Modem types.  Scroll to the desired modem type and click on 

it.   

The initialization strings for the TM4000 Init and TMUltra Init fields will be automatically configured (depending 

on the modem type).  The remainder of the fields can be completed by the user. 

 

IMPORTANT!.  Ensure that you do not add the dial prefix both here and in the FTS 

Telemetry page Telephone Number field.  The dial prefix is only required in one 

location.  

 

A detailed explanation of each of the fields can be found in Chapter Nine< Communication Type - FTS. 
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3.3.3 Communication Type – GOES 

GOES Telemetry (GOESTelem) is only applicable to those remote stations using GOES Satellite Transmitters.  

GOES Telemetry retrieves station’s data from the GOES ground station at Wallops Island via an Internet 

connection to the National Oceanic Atmospheric Administration (NOAA’s) Local Readout Ground Station (LRGS).  

Supported GOES data formats are: BLM, Time Ordered, Water Surveys Canada, and pseudo-binary. 

 

 
Figure 3-10: GOES Telemetry – LRGS Communication Setup screen 

NESDIS ID:  The NESDIS ID field is the unique identifier for the remote site’s GOES transmitter.  The identifier is 

an 8 character identifier supplied by NESDIS (National Environmental Satellite Data Information Service) for 

a GOES transmitter at a specific remote monitoring site.  

Data Format Type: Use the drop down menu to select the Data Format type your system will be using (BLM, 

Time Ordered, Water Surveys Canada, or pseudo-binary).  A detailed explanation of each Data Format Type 

is found in Chapter 8<Communication Type – GOES Telemetry.  

Global Settings:  Click the Global Settings button to open the LRGS Global Settings window.  The settings in 

this window identify the particulars of the LRGS servers at the GOES ground station from which the data will 

be retrieved.   

First Tx:  This field is an optional field where the user may enter when the first GOES transmission from the 

remote site is scheduled to occur.  This field is for user reference only and does not need to be populated in 

order to receive station data via the LRGS connection (i.e., 00:15:30 would indicate that the first GOES 

transmission would occur at 15 minutes 30 seconds after midnight UTC time). 

Interval: The Interval field is an optional field where the user may enter how often the GOES transmission 

occurs (i.e., 01:00:00 is hourly).  This field is for user reference only and does not need to be populated in 

order to receive station data via the LRGS connection. 

Baud Rate: The Baud Rate field is another optional field where the user may enter the Baud Rate of the remote 

sites transmission (i.e., 100 bps, 300 bps, or 1200 bps).  Again, this field is for user reference only and does 

not need to be populated in order to receive station data via the LRGS connection. 
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IMPORTANT!  The Selected Ordered Message Fields column must be populated with 

the desired Database fields to be contained in the message, otherwise an error 

message is received (seen in the Call Status Error Details column). 

 Example error messages: 

“Sensor fields not defined Write data failed – field mismatch”  if the Selected Ordered Message Field is 

left blank. 

“[NESID] Had [#] mismatch packet(s) Write data failed – field mismatch”  if the message fields entered 

incorrectly (ie: missing some fields). 

 

Refer to Chapter Nine<Communication Type - GOES Telemetry for a detailed explanation of GOES telemetry 

settings.  

 

3.3.4 Communication Type – GSNET 

GSNet Telemetry is only applicable to those systems using FTS Globalstar Satellite modems (FTS models: GS-

4000, Globalstar, or Globalstar-QD) as the telemetry device at the remote stations.   

 

 
Figure 3-11: GSNet Communication Setup  

Input the information in the description area of the GSNet Communication Setup screen.  Note that the Area 

Code and Telephone Number fields for the remote site’s modem can only contain numerals ( other characters 

or spaces are invalid).   

Password:  If a password has been set in the logger, the password must be entered here.   
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Data Overlap:  In order to avoid possible data gaps in the station’s database, the value set in the Data Overlap 

field should be greater than the value set in the GSNet Host Service Max. Wait for Server field 

Use Global GSNet Host:  select this when a GSNet Host Service has been defined using the Edit Global Settings 

function. 

Use GSNet Host Settings Below:  select this when the GSNet service for the remote station has been defined 

locally. 

For both a Globally and a Locally defined GSNet Host, the IP Address, Port Number and working folder for the 

computer running the GSNet Host service must be entered. 

 

IMPORTANT:  A user must have read and write access rights to the Working Folder 

Max Wait for Server:  this is the maximum time StreamTrac will wait for a reply to an SMS data request.  Once 

this time is exceeded the call will be deemed to have failed.  See Data Overlap (above). 

Refer to Chapter Nine<Communication Type – GSNet for a detailed explanation of the GSNet Telemetry. 

 

3.3.5 Communication Type - Ubicom 

UbiCom telemetry only applies to those stations using FTS UbiCom.  UbiCom is a dual mode communication 

system which uses either Iridium satellite or terrestrial cellular communications networks to exchange 

information and data between a remote station and the StreamTrac Database.  

 

When initially setting up the Ubicom Communication Method, you will be prompted to enter a descriptive 

name. 

 

The figure shown below is an example of a typical Ubicom Communication Setup.  Input the required fields then 

select OK. 

 

 
Figure 3-12:  Ubicom Setup 

Refer to Chapter Nine<Communication Type – UbiCom for a detailed explanation of the UbiCom Telemetry. 
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3.4 CALCULATIONS TAB 

The Calculations tab is used to build custom calculations as well as map logged variables to common field 

names which are used in certain calculations.  

Every data file may contain fields whose values result from calculations.  This may be as simple as calculating 

Discharge from Stage, or a range of calculations that record intermediate values for use in other calculations. 

The program will automatically perform calculations immediately after calling for data or after importing data.  

 

 

Map Common Field Names and Sediment and Carousel-Bottle Mapping Fields:  The field names appearing 

in these two sections are used in a variety of calculations which run in the background of the program 

(current conditions and the Station information dialog box on the map view, for example).  Because variable 

names can be customized, the common names must be mapped to the actual variable name which houses 

the data.  Use the drop down menus to select the variable names for the listed common mapping fields.    

Calculations will use the data from these mapped fields.   

Note that this function is separate from any Custom Calculations developed. 

3.4.1 Custom Calculations 

There are a variety of custom calculations available using values derived from the datalogger. However, some 

calculation fields may require values that are not derived from the datalogger.  In this case, the calculations must 

be initiated after editing the required data and building your own formula. 

 

To view an existing calculation or to build a calculation/formula, click the Set-up Custom Calculations button.   
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Figure 3-13: Calculations Setup  

 

This will bring up the Calculations for station ”name” screen which displays a list of existing calculations.  From 

this page existing calculations can be modified or new calculations built.  

Calculations are performed in the order they are listed, from top to bottom.  The order of execution can be 

changed using the Move Up and Move Down buttons.  First select the calculation you wish to move by clicking 

on it, then click either Move Up or Move Down to move the calculation up or down in the list. Calculations are 

performed from the top down. 

 

 
Figure 3-14:  New Calculation 

Open an existing calculation by double clicking on it.  Build a new calculation by selecting the “New” button. 

 

This will bring up the Choose a new calculation type screen. 
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Figure 3-15:  New Calculation Types 

Select the desired Calculation Type from the menu, then Next.  Detailed explanations of each Calculation Type 

are found in the following sections. 

To modify an existing formula calculation either double click on the existing calculation or select it and click the 

Modify button. 

Note: If date ranges for two formulas overlap the second calculation will overwrite the results of the 

initial calculation. 

If the referenced data has been changed, the results of the calculation will change and the new values will 

overwrite the old values the next time calculations are refreshed (i.e. clicking the Refresh button on a graphing 

screen). 

 

3.4.2 BC Danger Calculation 

The BC danger rating system uses the BUI and FWI values calculated from the Canadian Fire Danger Rating 

System to calculate a BC Danger value result. This result will always be a value of 1 thru 5 color coded as shown 

in the figure below. 

 

 
Figure 3-16:  BC Danger rating system color codes 
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The BC Danger Calculation setup requires the user to enter a calculation name/description, to map the FWI and 

BUI fields, to select the BC Danger Region and to set the calculation schedule. 

 

 

Figure 3-17: BC Danger Calculation Setup 

Calculations are the result of the intersection of in the BC danger rating tables of the FWI along the X-axis and 

the BUI along the Y-axis.  There are three BC danger regions represented by three BC Danger rating tables in 

Figure 3-18. 

 

 
Figure 3-18: BC Danger Region Tables 

Calculation name / description 

Source fields used to determine the 
danger rating via the selected table below 

Danger Region table Selection: 
There are 3 tables with different 

BUI and FWI intersections. 

Schedule: start time and period 
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IMPORTANT! The BC Danger Calculation uses fields created in the Canadian Fire 

Codes Calculation, therefore the Canadian Fire Codes Calculation MUST be defined 

prior to the BC Danger Calculation. The Canadian Fire codes Calculation must also 

appear before the BC Danger Calculation in the calculation list. 

 

3.4.3 Canadian Fire Codes Calculation 

This module performs calculations according to the Canadian Fire Danger Rating system. The dialog requires 

you enter a calculation name/description, map the source fields, and set the calculation schedule. All target 

fields will be created for you once the calculation is saved. This module will also allow you to create more than 

one model. In the case of multiple models the module will add a numeric suffix to the target field for each 

additional model that is created. 

 
Figure 3-19: Canadian Fire Codes Calculation 

 

Start-up values are required before the Canadian Fire module can begin its calculations. These must be entered 

at the calculation start point.  The following fields require start up values: hFFMC, DMC, DC, and FFMC.  The start-

up values can be entered in the data view/edit screen as shown below. The values shown are just for example 

purposes. Appropriate values must be entered for your particular regions. See your local fire expert for optimal 

start values. 

Calculation name / description 

Required source 
fields. Fields must 
be entered before 
the calculation can 

be run. 

Target fields will be 
created 

automatically. The 
names cannot be 

changed. In the case 
of multiple fire code 
calculations the field 

name will be 
appended with a 

numeric value  
(e.g. _1) 

Schedule: start time / end time 
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Figure 3-20: Initialize Canadian Fire Code variables 

3.4.4 China FDR Calculation  

This module performs calculations based on the China Fire Danger Rating system.  The dialog requires you enter 

a calculation name/description, map the source fields, and set the calculation schedule. All target fields will be 

created for you once the calculation is saved.  

 
Figure 3-21:  China FDR Calculation  

 

 

 

Set initial values for the target 
fields before the calculation is run 

Locate the record at the observation time and prior to the 
calculation start time (e.g. 12:00). If a record does not exist 

then select a record just after the calculation start time. 
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3.4.5 Formula Calculations 

Formula calculations allow you to setup custom calculations using an FTS scripting language.  Programming 

knowledge is essential to correctly use this feature.  FTS assistance should be sought prior to developing custom 

calculations. 

IMPORTANT!  Contact FTS Technical Support for guidance to build custom calculations. 

A simple single line formula can be applied to a target field or a more complex formula can be entered into the 

program box.  Variables used in the formula or program must either be pre-defined (present in the read only 

field’s box) or may be entered as internal variables in the user variables box.  Pre-defined fields exist in the 

station’s data while user variables are only used inside the calculation.  The schedule for the custom formula 

calculation is also set through this window.  

 

 
Figure 3-22Custom Formula Calculation setup 

Note:  

 If date ranges for two formulas overlap the second calculation will overwrite the results of the 

initial calculation. 

 If the referenced data has been changed, the results of the calculation will change and the 

new values will overwrite the old values the next time calculations are refreshed (i.e. clicking 

the Refresh button on a graphing screen). 

Schedule: start time and period 

Example 
program 
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 FTS Scripting Language Syntax 3.4.5.1

The following tables show the scripting language to be used in developing custom formulas.  

 

Variable types:  

 

x,y         : numeric - (integer, float) 

a,b         : Boolean (1 or 0) 

s,t,v       : string 

d           : DateTimeString  (StampString)  

 

 

Type conversion: ¡¡ 

 

 Boolean (1/0):   Logic(x) 

numeric:             Numeric(s) 

string:                String(x) 

char:                  Char(x)  

 integer:            Ascii(s) 

all types:           Eval(f)   // where f string is formula in [...] 

string :               NumBase(x,base) // base from <2..16> 

integer:              BaseNum(s,base) // base from <2..16 

Math operations:  

numeric (integer): x Div y,  x Mod y 

Math functions:  

Abs(x), Frac(x), Trunc(x), Heaviside(x) or H(x), Sign(x), 

Sqrt(x), Ln(x), Exp(x), 

Cos(x), CTg(x), Ch(x), CTh(x), Sin(x),  Sh(x), Tg(x), Th(x), 

ArcSin(x), ArcCos(x), ArcTg(x), ArcCtg(x), 

MaxVal(x [,y, ...]),  MinVal(x [,y, ...]), 

SumVal(x [,y,...]),   AvgVal(x [,y, ...])  

String operations:  

s || t , 

s Like t,      // (%,_) 

s Wildcard t   // (*,?) 

"ABC" //string literals must be surrounded by double quotes 
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String functions:  

integer: Length(s), Pos(t,s)   // Note: String indexing starts from 1 

string:  Trim(s), TrimLeft(s), TrimRight(s), Upper(s), Lower(s), 

Copy(s,x,[y]), CopyTo(s,x,[y]), Delete(s,x,[y]) 

Insert(s,t,x),   

Replace(s,t,v,[1/0=ReplaceAll,[1/0=IgnoreCase]] ), 

IFF(a,s,t);    //IF a>=1 then Result:=s else Result:=t 

numeric: Eval(s) 

Date and Time functions:  

integer: Year(s), Month(s), Day(s), WeekDay(s), 

string:  Trim(s), TrimLeft(s), TrimRight(s), Upper(s), Lower(s), 

numeric: StrToStamp(d) 

string:  StampToStr(x), StampToDateStr(x), StampToTimeStr(x) 

Interpreter, key words & syntax:  

IF ...   THEN { ... } [ELSE { ...}]  

WHILE ... DO { ... } 

PROCEDURE <ProcedureName> { ... } 

EXEC <ProcedureName> 

BREAK 

CONTINUE 

EXIT 

BEEP 

END.  //program end 

/* note */ 

Note: all variables are global variables 

Statistical  

@AVG(FieldName, Days, Hours, Minutes, seconds) 

@SUM(FieldName, Days, Hours, Minutes, seconds) 

@MIN(FieldName, Days, Hours, Minutes, seconds) 

@MAX(FieldName, Days, Hours, Minutes, seconds 

        *** These functions are database intensive and may cause the calculation to 

               run slower. 

Note: all variables are global variables 
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 Syntax Examples 3.4.5.2

Simple Stage Calculation: 

if Stage>=0 then  

{ 

Discharge  :=  (6*Stage^1.538)*0.03; 

}   

else  

{ 

Discharge  :=   0; 

} 

end. 

 

Calculate Discharge From Stage(Multi-case): 

if Stage>0 then  

{ 

Discharge  := 0.75530059 + (0.18399245*Ln(Stage)) +  

                         (0.029399358*Ln(Stage)^2) + 

                         (0.00060295268*Ln(Stage)^3); 

Discharge  := Discharge  + (0.0025560321*Ln(Stage)^4) +  

                         (0.00037275221*Ln(Stage)^5) +  

                         (0.000404684*Ln(Stage)^6); 

Discharge  := Discharge +(0.000016092901*Ln(Stage)^7)+ 

                         (0.000010707796*Ln(Stage)^8); 

}   

else  

{ 

Discharge  :=   0; 

} 

end. 

Simple Shifting Example: 

Stage := Stage + 1.370 

end. 

Flagging Example: 

if Turb>100 then  

{ 

TurbFlag := 1 

} 

else 

{ 

TurbFlag := 0 

} 

end. 
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 String Usage Example: 

sRun := DataErrors; 

sNew  := ""; 

iCommaPos:=1; 

while (iCommaPos>0) do 

{ 

  iCommaPos:=Pos(",", sRun); 

  if iCommaPos > 0 then 

  { 

    sEach := Copy(sRun, 1, iCommaPos-1); 

    sRun  := Copy(sRun, iCommaPos+1, Length(sRun)); 

  } 

  else 

  { 

    sEach := Copy(sRun, 1, Length(sRun)); 

    sRun:=" "; 

  } 

  iPos := Pos("#5", sEach); 

  if iPos <=0 then 

  { 

   if Length(sNew) >0 then 

   { 

      sNew := sNew || ","; 

   } 

    sNew := sNew || sEach; 

  } 

} 

DataErrors := sNew; 

End. 

 

3.4.6 Lookup Table Calculation 

This calculation converts data from a source field value to a target field value using a Lookup Table of reference 

source and target values.  It is commonly used to convert stage values to discharge (or flow).   

The calculation will review the data record, find the Source Field data, and then convert those values based on 

the Target Values in the Lookup Table.  The converted Target Value will then be saved to the Target Field line in 

the data base under the station’s name.   

IMPORTANT!  If the target field selected is a data point, the data will be overwritten by 

the Lookup Table values.  However, the original data values will be available from the 

RAW file. 

 

NOTE!  Source Values which are beyond the minimum and maximum Lookup Table 

values will be converted using the nearest value in the table. 
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Use the drop down menus to select the Source Field and Target Field.  If the desired Target Field does not exist, 

one can be added from the Stations>Description>Add Field function.  

Then the Lookup Table must be built.  It can be populated in two ways: manually or by loading a CSV file.   

CSV FILE 

The CSV file must contain two columns: the first column contains the source values and the second column 

contains the target values.  Press on the Load CSV button and browse to the file.  This will over write any values 

already in the Lookup Table.  The table will automatically be ordered in ascending order of Source Values.   

MANUALLY 

Type in the desired Source and Target Values.  Striking Enter will bring up the next line.  Lines can also be 

entered by using the Insert and Repeat Insert buttons.  The table will automatically be ordered in ascending 

order of Source Values.   

Interpolate:  When selected a proportional value between the source and target values will be used.   

 

 

Figure 3-23:  Lookup Table Calculations -  

Source Field and Target Field:  Use the drop down menus to select the fields. 

Load CSV:  Lookup table data can be loaded from a CSV file.   

Repeat Insert:  Selecting this will bring up an Enter Table Values box.  Fill in the desired Source and Target 

Values and then Enter.  The values will be entered into the Lookup Table. 
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Insert:  Inserts a line in the table above the last entered value or the selected line.  This line is populated with 

zeroes but they can be overwritten by selecting them and typing in the desired value. 

Delete:  Deletes the selected line.  

When and how long:  Input the Starting time and the Ending time.  If the Open Ended box is checked the 

conversion process will be continual. 

 

3.4.7 NFDRS 

This module performs calculations according to the U.S. Fire Code National Fire Danger Rating Systems (NFDRS)    

 

 
Figure 3-24:  NFDRS Calculation Set-up screen 

Observation Hour:  This field determines when the daily calculations will be stored. The default entry for this 
field is 13 (13:00 Standard Time) and is the accepted observation time for NFDRS calculations. 

 
Annual Precipitation:  Enter the typical annual precipitation (in inches) for the site. If you are not sure what it is 

you can enter an estimated value, but you should make every effort to be as close to the typical value as 
possible. 

 

Lightning Risk:  Lightning Risk Scaling Factor is a multiplier that allows for higher lightning-caused fire 
occurrences. It is "used to account for area-specific fuel conditions that affect the fire-starting efficiency of 
lightning, - Bradshaw, et al, 1983".  The default for this parameter is 1.0, which should be adequate for most 
users.  

Calculate Hourly Fire Codes:  If you wish to have fire codes calculated every hour in addition to the daily 
calculations, make sure this box is checked. 

 
Use Measured Woody F.M.:  Check this box if you want the software to use a measured woody fuel moisture 

value.  Ensure the Fuel Stick Temp Field in Field Name Mapping is input. 
Wood F.M:  Enter the woody fuel moisture value. 
 
Stick Date:  Set this field value to the data of the woody fuel moisture measurement. The software will calculate 

codes for thirty (30) days after the measurement date.  



StreamTrac  

700-ST-MAN  Rev. 2 -  29 Oct 2015  Page 41/155 

 
State of Weather (SOW):  SOW must be entered manually unless the station returns a fuel stick temperature 

(FST) value.  If FST data is available, then the NFDRS module, will calculate an approximate SOW value by 
comparing the FST to the Air Temperature (Temp) using the following algorithm: 

 

 
 

Human Risk Factor:  The current day's Human Caused Risk factor ranges from 0 to 100 and contributes to the 
Human Caused Occurrence Index (MOI). This is a semi-calculated field. The NFDRS module will not overwrite 
existing values. By default, the NFDRS module will store a value of 20 in the MCR field on weekdays and a 
value of 40 on weekends. You can edit it different values for any particular day.  

 
Fuel Model List:  Lists the fuel models that have been defined for the system.  There is no limit to the number of 

fuel models which can be created for each station.  
 
 Click on the Add button to add a new fuel model to your station, or click on an existing model and click 

Modify to bring up the Modify NFDRS Model screen:  
 
 

 
Figure 3-25:  Adding Fuel Model 

 System:  This allows you to select the NFDRS fuel modeling system (1978 or 1988) that is used for this fuel 
model.  

 
Note that if you select NFDRS 1988, the selections for Shrub Type and Set 1 Hr = 10 appear on the dialog.  

 
Use the drop down menus to select Model, Slope, Climate, and Grass and Shrub Type.   

 
 Set 1 Hr=10 checkbox:  If you have selected the 1988 fuel model then you will have the option of choosing 

to set the fine dead fuel moisture equal to the 10-hour time lag fuel stick moisture.  
 
Field Name Mapping:  In order for the NFDTS Calculation to run, the listed fields should be mapped.  Use the 

drop down menus to select the variable names for the listed common mapping fields. 
 

 



StreamTrac  

700-ST-MAN  Rev. 2 -  29 Oct 2015  Page 42/155 

 
Figure 3-26:  Field Name Mapping 

 

3.4.8 Water Balance Calculation 

The water balance calculation returns target field values based on the region type, elevation and source field 

inputs.  The module also requires you set the calculation schedule.  The calculation assumes that only one data 

record per hour exists for the station. 

 
Figure 3-27: Water Balance Calculation setup 
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3.5 SCHEDULE TAB 

The Schedule allows the user to enter the calling schedule for the remote station data logger.  Through this 

configuration tab the user is able to specify when and how to call the station, the number of retries per call 

attempt, and, in addition to having the data saved in the StreamTrac Database, whether or not to write the 

retrieved data to a CSV (comma separated variable) file.   

 

 
Figure 3-28:  Station Admin Menu> Schedule Tab 

Scheduled data calls always retrieve only the data required to update the StreamTrac Database.  Prior to 

placing a scheduled call, the Calling Service will examine the station’s database to determine the date and time 

of the most recently stored data.  In order to minimize data collection times and potential airtime charges, the 

subsequent scheduled call will only request the data from the last record stored in the database to the current 

time (up to a maximum number of days – the default setting is 3 days but this can be changed). 

NOTE:  All times indicated are in local time. 

 

Enable Scheduled Data Collection  

There are two ways to automatically collect data from remote stations: 

1) Stations can have individual call schedules defined using the Schedule 

configuration tab, or 

2) Stations can be added to a Station Group and then have a common call schedule 

defined for the specific group (refer to the Stations>Group Setup menu section 

of this manual for details on this option). 

In order to individually schedule a station for automated data collection then the Enable Scheduled Data 

Collection checkbox must be selected in order to allow the Calling Service to individually collect data for the 

selected remote station. 

When scheduled data collection is enabled, a call schedule with fixed daily periodic intervals and other daily 

non-periodic times can be specified.   

 

Individual station 
schedule 

Additional group 
and export calls 
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Use Fixed Schedule 

The Use Fixed Schedule checkbox must be selected in order to specify periodic calling times.  The Fixed 

Schedule is a daily schedule whose cycle restarts at midnight each day.  In Figure 3-28 the defined Fixed 

Schedule will cause the Calling Service to call the Test Station hourly starting at 12:00 (noon) until 23:59 (11:59 

p.m.). 

Other Times 

The Other Times line is used to specify daily non-periodic calling times.  In Figure 3-28, the defined Other Times 

will cause the Calling Service to call the Demo station at 4:05 am (04:05) and 10:05 pm (22:05) each day in 

addition to the periodic call times defined by the Fixed Schedule.  Other Times should be entered in 24 hour 

format (hh:mm) with a space between the different call times. 

Comm. Type 

The Comm. Type drop-down box is used to select which of the station’s defined communication methods will 

be used by the Calling Service when making the individually scheduled station calls.  The selected 

communication method can be different from the default communication method specified in the 

Communication configuration tab.  The default communication method is used by the Calling Service when the 

user schedules a station to be called as part of a Station Group.   

Time Synchronization 

The Perform Logger Time Synchronization (UTC) check box allows the user to synchronize the datalogger to 

the PC clock and automatically offset to the Logger’s local time by using UTC as the benchmark time. This 

synchronization can be set to a schedule similar to the data collection and export schedules. 

Additional Group Schedules Affecting This Station 

The Additional Group Schedules Affecting This Station table displays all group calls and exports that include 

the current station.  Double clicking on a listing in this table will open the corresponding group in the Group 

Manager or Export Template from the Export Template manager.  Right clicking on a group allows you to quickly 

open the Group Manager or the Template Manager for creating new Group Calls or Export Templates.  
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3.6 HYDRO YEAR TAB 

The Hydro Year tab permits the user to define the dates of the selected station’s hydro year. 

 

 

 
Figure 3-29:  Hydro Year Tab 

Use the drop down menu to select the desired station.  To add a new hydro year, select the Add 

button.  Input the desired dates.  Note that a “To” date one year from the “From “ date will be 

automatically entered.  Additionally, a Title will also be generated based on the selected dates and 

formatted as HYyyyy). This title can be changed if desired. 

 

 

 
Figure 3-30:  Hydro Year formatting 
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3.7 DATALOGGER PROGRAM TAB 

The Datalogger Program tab allows the user to retrieve the datalogger program from the datalogger, to edit the 

datalogger program and to send the datalogger program to the datalogger. Select the View/Edit Datalogger 

Program to launch the Datalogger Program window enabling these functions. 

 
Figure 3-31:  Datalogger Program Tab 

Use the Choose File button to navigate to the desired file, and select the Send Now or Get Now button 

as required.  

 

Figure 3-32:  Selecting a file 

Axiom Datalogger programs must be in .XML format.  

See sections 4.1.3.3 (Action Calls) for more details. 

 



StreamTrac  

700-ST-MAN  Rev. 2 -  29 Oct 2015  Page 47/155 

3.8 ATTACH NOTES TAB 

The Attach/Notes tab is intended to allow the user to store a wide variety of information about the station.  Files 

of any sort (i.e. site map & directions, site pictures, site contact information etc.) can be added in the 

Attachments section – much like attaching a file to your e-mail –while text entries can be typed in the Notes 

section.  The information entered in the Attach/Notes tab is solely for the user’s convenience as this information 

is not used by the Admin Application or the Calling Service.  Files and text added in the Attach/Notes tab are 

stored in the StreamTrac Database. 

 

  
Figure 3-33: Attach/Notes Tab 

Attach:  To add a file to the Attachments section:   

1) Click the Attach button located in the Attachments section. 

2) Browse to the desired file. 

3) Select the file. 

The file is now attached in the Attachments section and can be opened by double clicking on it.  

 

Delete:  To remove a file from the Attachments section: 

1) In the attachments section, click on the file you wish to remove.  The file 

should become highlighted with a blue background. 

2) Click the Delete button located in the Attachments section. 

The file is now removed from the StreamTrac Database and no longer shows up in the Attachments section. 

 

Notes:  Text notes can be typed or pasted into the Notes section.  Notes are saved in the StreamTrac Database 

when the user closes the Modify/Add Station dialog box or switches to another station. 
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3.9 STATIONS>GROUP SETUP MENU 

3.9.1 Group Manager 

A "Group" is the term used to identify a selection of stations which can have a single function applied to them. 

The Group Setup menu is the menu through which users can organize remote monitoring stations into groups 

for convenient data collection.  The Group Manager menu is used to create Station Groups, to select which 

stations belong to the various groups, and to schedule data collection for the group.  This window also provides 

the ability to select existing groups so that they can be modified or removed from the database.   

  
Figure 3-34:  Group Admin Menu 

Group navigation can be performed using the Group Name drop-down list or using the navigation buttons.  The 

navigation buttons located below the Group Name drop-down selector are used to single-step forwards and 

backwards through the group list   or to jump to the first or last group in the list  

 

 Group Tab 3.9.1.1

NEW GROUP 

New groups are added by clicking the New Group button on the Group Manager window.  The user will then be 

prompted to enter a name for the new group.  Once a group has been named, a list of currently defined remote 

stations will be displayed in the All Stations column.  The right-hand In Group window pane displays the 

stations which belong to the currently selected group.   

Stations are added or removed from the to the group using the arrows  

> : adds the selected station to the group, 

>> : adds all stations to the group, 

< : removes the selected station from the group, 

<< : removes all stations from the group. 
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DELETE GROUP 

To delete a station from the StreamTrac system, the user simply navigates to the group they wish to delete and 

then presses the Delete Group button.  As a precaution the user is prompted to confirm the delete before the 

group is removed from the database.  When deleting a group, only the station group is deleted, the individual 

stations in the group remain untouched. 

 

INTER-STATION CALL DELAY 

Enter the desired time delay between station calls here.   

 

 Schedule Tab 3.9.1.2

The Schedule tab is used to enter the calling schedule for the station group.   

The functionality of the Schedule tab in the Group Admin menu is identical to the functionality of the Schedule 

tab in the Station Setup menu.  The only exception is that when the Calling Service processes a scheduled group 

call, each station in the group will be called using its default communication method.   

If a station and its associated group are both scheduled to be called at the same time and both calls are using 

the same communication method, the StreamTrac will optimize the calling regime by only placing one station 

call.  

Refer to the schedule portion of the STATIONS> Station Setup> Schedule Tab section of this manual for details 

on configuring call schedules. 

  
Figure 3-35:  Group Admin Schedule Tab 
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3.10 STATIONS>UTILITIES 

This is used to update the Ubicom Firmware when required.  The FTS Firmware Updater tool must be 
used.  Instructions will be included with the Firmware release and included on the FTS Support web 
page. 

3.10.1 Upload UbiCom Firmware 

 

 

Ubicom ID:  Enter the assigned ID number here. 

Password:  Enter the Ubicom password here.  Use the password that was created when the Ubicom was setup. 

Gateway URL:  This is the URL of the Gateway you are operating on.  If unsure, contact FTS Service. 

Firmware File:  Browse to find the file (usually downloaded from a USB stick) 

Once the above information has been entered and the file path identified, select Upload. 
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CHAPTER 4 DATA MENU 

4.1 DATA>COLLECT DATA & TELEMETRY CALLS MENU 

 

Through the Collect Data & Telemetry Calls menu, calls can be manually initiated to remote monitoring 

stations.  Calls made can retrieve data and other site information as well as set logger time and send and retrieve 

Data logger programs from an individual station or station group.  Once the Call button is clicked, the Call Status 

screen will be displayed so the user can monitor the call’s progress. 

4.1.1 Manually Calling Stations/Groups  

The Call Station radio button enables the drop-down station list which allows the user to select which station 

they wish to contact. The Call Group selector button enables the drop-down group list which allows the user to 

select which station group they wish to contact.   

 

 

 
Figure 4-1:  Manually Calling Stations 

4.1.2 Communication Method 

When calling a station the user has the choice of which communication method the call should use to contact 

the station.  As a convenience, the station’s default communication method is pre-selected (highlighted in blue).   

The Communication Method selection box is the feature which enables multiple remote users to manually call 

the remote stations because it allows users to place the call using the communication method defined 

specifically for their computer.   

Action Calls 
 

Information 
Calls 

 

Data Calls 
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The Communication method and device type will determine which kinds of Data Logger Calls can be made. 

Retries  

The Retries box allows the user to select how many calling attempts, in addition to the first call, should be made 

in order to successfully retrieve the requested data.  Note that call retries does not apply to GSNet 

communication type calls. 

Call: this initiates a manual call 

Cancel: this cancels a call in progress 

 

 

4.1.3 Datalogger Calls 

Data Logger calls are calls that communicate with the data logger located at the remote site.  There are three 

types of Data Logger Calls:  Data calls, Information calls, and Action Calls (see Figure 4-1). 

Data Calls: Data collected using manually initiated data calls is stored in the station’s database (similar process 

as data collected through scheduled calls).  This allows users to backfill missing data or to bring the database 

up-to-date with the latest data available from the data logger. 

Information Calls: Information returned from site information calls (current conditions, logger information, or 

special calls) is only displayed in the Information Call Results window at the time the call is made.  This 

information is not stored in the station’s database. 

Action Calls: These calls will initiate the selected action. 

Available Data Logger Call methods will vary depending on the device and communication type.  Only those 

Data Logger Calls compatible with the Communication Method and device type will be able to be selected (the 

checkboxes will be white).  

 

IMPORTANT!  When using GOES Telemetry, only data calls are supported as the 

StreamTrac retrieves station data from the GOES ground station rather than directly 

from the data logger. 

 

 Data Calls 4.1.3.1

COLLECT NEW DATA 

The Collect New Data checkbox provides the user the option of collecting only the data required to bring the 

database up-to-date or collecting all data within a period backdated from the current time (i.e. last 2 hours). 
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Figure 4-2:  Collect New Data  

Collect New:  When the Collect New From Last Time in Data File to Current Time radio button is selected, the 

data call will request the data logger return the data required to bring the station’s database up-to-date.  

Prior to calling the station, StreamTrac queries the station’s database for the date and time of the last data 

entry so that only the information required to update the station’s database to the time of the call (as 

provided by the calling computer’s clock) is requested from the data logger.   

Note that the Collect New From Last Time in Data File to Current Time is the type of call that is performed when 

the station is automatically called by the Calling Service. 

Latest Amount:  When the Latest Amount radio button is selected, the data call will request the data logger 

return a specific time period of the most recent data stored in the data logger (i.e., the last 2 days or the last 

3 hours etc.).  The date and time of the returned data may or may not coincide with the time shown on the 

calling computer as the data returned by this call is dependent on the time set in the data logger.  The data 

returned from the data logger is saved in the station’s database.     

 

COLLECT DATE RANGE 

The Collect Date Range checkbox is used to request a specific range of data from the data logger by specifying 

the range start and end times.  This type of call can be used to backfill data missing from the station’s database 

(if the data is actually available from the data logger). 

 
Figure 4-3: Date Range 

 Information Calls 4.1.3.2

GET CURRENT CONDITIONS  

The Get Current Conditions checkbox is used to request the remote data logger return the data from an 

immediate reading of the sensors specified in the data logger program.  The Current Conditions information 

returned from the data logger is displayed on the Admin Application’s Information Call Results window.  Current 

Conditions data is not saved in the station’s database.   
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GET LOGGER INFORMATION  

The Get Logger Information checkbox is used to request information about the data logger at the remote site.  

Logger Information data is not saved in the station’s database. 

GET LOGGER AUDIT LOG  

The Get Audit Log  checkbox is used to request information about data logger changes and other events such as 

“Set time” and , “Logger restarted” at the remote site.  Audit Log data is not saved in the station’s database. 

 Action Calls 4.1.3.3

SET LOGGER TIME  

The Set Logger Time checkbox is used to set the time of a data logger. The time can be set to the current time of 

your PC clock or you can set it to a manually pre-adjusted time. 

 
Figure 4-4: Set Logger Time 

 

SYNC LOGGER TIME  

Selecting this will synchronize the logger time to the UTC on GPS enabled stations when the station is called.   

 

GET LOGGER PROGRAM  

The Get Logger Program checkbox is used to download a copy of the data logger program (DLP) to the 

StreamTrac Database.  Once downloaded, a copy will be displayed in the screen, and it can be copied (and other 

actions) by using the right click function on the mouse.  As well, the program will automatically be saved to the 

Station Set-up and can be viewed from the Datalogger Program tab of the Station Set-up dialog. 
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Figure 4-5:  Get Logger Program 

The datalogger program can also be copied to a different target file if desired.  Use the Choose File button to 

browse to the file then select Get Now.  

LAUNCH SEND LOGGER PROGRAM  

The Launch Send Logger Checkbox is used to send a program to the logger.  The same screen used to Get 

Logger Program will open (see above).  Use the Choose File button adjacent to the File to send to Logger 

field to browse and select the file.  Once this step is completed, that data logger program is automatically 

entered into StreamTrac and the Station Setup>Datalogger Program will be updated.  Click on the Send Now 

button to complete the process.   
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4.1.4 Telemetry Device Calls 

Telemetry Device Calls are special calls that communicate with specific telemetry devices located at the remote 

site, namely the FTS Globalstar (GSNet) satellite modem and the RMX radio modem.  These devices have the 

ability to provide diagnostic and configuration information. 

Information retrieved through special calls is only displayed in the StreamTrac Information Call Results window 

and is not saved in the station’s database.   

 

 

 

Figure 4-6: Telemetry Device Calls – GSNet 

 Globalstar Satellite Modem (GSNet)Calls  4.1.4.1

The FTS Globalstar Satellite modem can provide its control board configuration information and log files.  These 

features are only available when calling the modem using a GSNet telemetry method. 

Refer to the FTS Globalstar Satellite Modem Operating Manual (FTS manual 700-GLOBALSTAR) for detailed 

information on the FTS Globalstar modem. 

When a GSNet communication method is selected, a series of options appears in the Telemetry Device Calls box.  

Select the desired action from the list. 

GS1- Get Configuration: this special call retrieves the remote site’s Globalstar modem configuration settings. 

GS1- Get Call Log: this special call retrieves the call log file from the remote site’s Globalstar modem control 

board.  This file contains time-stamped information regarding the call time and duration of successful 

communications with the Globalstar modem.  Both asynchronous and GSNet calls are recorded in the 

control board call log. The time set in the control board is used as a reference for these messages. 

GS1- Get Audit Log:  this special call retrieves the audit log file from the remote site’s Globalstar modem control 

board.  This file contains time-stamped messages of what the control board considered to be anomalous 

events.  The time set in the control board is used as a reference for these messages. 

GS1- Clear Call Log:  this special call empties the call log file from the remote site’s Globalstar modem control 

board.  The fact that the call log was cleared is recorded in the control board’s audit log. 

GS1- Clear Audit Log: this special call empties the audit log file from the remote site’s Globalstar modem 

control board.  The fact that the audit log was cleared is recorded in the control board’s audit log. 

 RMX Radio Modem Calls  4.1.4.2

The RMX radio modem can provide its configuration information and log files as well as the station identifiers 

(station IDs) of the other RMX modems to which it can communicate. 
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Refer to the RMX Radio Modem Transceiver Operating Manual (FTS manual 700-RMX) for detailed information 

on the RMX radio modem. 

When an RMX Radio Modem communication method is selected, a series of options appears in the Telemetry 

Device Calls box.   

RMX – Get Neighbours:  this special call causes the remote site’s RMX to transmit a query to determine which 

other RMX units are within its RF range.  The remote site RMX returns the station IDs of the RMX units which 

reply to the query.  The returned station IDs are given in hexadecimal format (base 16) as indicated by the ‘h’ 

suffix.   

This call can be used to build a radio cluster diagram (determine radios paths) as the user can systematically 

call successive RMX radio modems to determine modem RF connectivity. 

RMX – Get Radio Quality Log:  this special call retrieves the radio quality log file from the remote site’s RMX.  

This file contains data regarding the quality of the radio transmissions with neighbouring RMX modems.     

RMX – Get Information:  this special call retrieves the remote site’s RMX configuration settings as well as the 

current RMX time. 

RMX – Get Audit Log: this special call retrieves the audit log file from the remote site’s RMX.  This file contains 

time-stamped messages of what the RMX considered to be anomalous events.  The time set in the RMX is 

used as a reference for these messages.     
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4.2 DATA>SHOW CALL STATUS MENU 

 

The Call Status window is the screen that allows the user to view the status of past, present, and queued station 

calls.  The Current Status tab is automatically updated to show the status of the most recent calls while the 

History tab allows the user to selectively view previously completed calls. 

 

 
 

Figure 4-7:  Call Status Screen 

4.2.1 Current Status Tab 

The Current Status tab shows the status of all queued, active, and recently completed station calls.  This screen 

is automatically refreshed from the information in the StreamTrac Database.  Call Status information for 

completed calls not shown on the Current Status tab can be viewed using the History tab.  

A manually placed call can be cancelled by selecting it (the call background will turn blue), right-clicking the 

mouse, and then selecting the cancel call option.  After canceling a call, it may take a few seconds for the 

cancelled call’s status to change.  AutoCaller service calls cannot be cancelled.  Other right click functions 

include: 

1) Collect Data: brings up  the Data>Collect Data and Telemetry Calls screen for the chosen station 

2) Data View:  brings up the Data>View/Edit screen for the chosen station 

3) Station Set-up: brings up the Stations>Station Setup screen for the chosen station   

 

The Current Status tab has several fields to accurately report the status of each station call.  An explanation of 

each field follows. 

Reference:  The Reference field displays the originator of the call coupled with a unique reference number.  This 

can be either the Calling Service (displayed as AutoCaller Service) or StreamTrac.  This field allows the user to 

distinguish between scheduled AutoCaller calls and manually placed calls. 

When RMX radio modems that are part of the same radio cluster are called as a group, the reference number 

for these calls will be the same as the RMX is able to handle simultaneous data calls.  
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Request Date/Time:  The Date/Time field displays the date and time the call was placed into the calling queue.  

Group/Station:  The Group/Station field displays the group and name of the station being called.  

Comm Type:  The Comm Type field displays the whether the call uses regular FTS telemetry, GSNet telemetry or 

GOES Telemetry to communicate with the remote station. 

Call Type:  The Call Type field displays what information is being requested from the remote station (i.e., Latest 

Data, Current Conditions, Logger Information, etc.).  

Call Details:  The Call Details field displays specifics of the call to the remote site.   

 1) For an FTS communication type call this field will display call retry information, the COM port  

  used for the call and, if applicable, the remote site’s phone number.    

 2) For a GSNet communication type call this field will display the ID number of the outgoing SMS e- 

  mail, the remote site’s phone number, the GSNet server’s IP address and port number, as well as  

  the timeout value (in seconds) for the GSNet call.  Call retry information is also displayed;   

  however, GSNet  type calls do not  support call retries. 

 3) For a GOES communication type call this field will display the IP address and port number used  

  for the connection to the LRGS database as well as call retry information. 

Call Status:  The Call Status field displays the state of the call to the remote site.  One of six messages is 

displayed in this field (see below).   

Queued : The call is waiting for a COM port or phone number to become available. 

Calling : The call is in progress. 

Complete : The call cycle has been completed. 

Cancelled : The call was cancelled before the call process was completed.  A manual call can be 

cancelled by the user while a scheduled call will be cancelled by the Calling Service 

if the call does not proceed in a timely manner. 

Retry Wait : The previous attempt of this call was unsuccessful and the call is now waiting for its 

next call attempt. 

Call Progress:  The Call Progress field displays information on each step of the call to the remote site (i.e., 

initializing modem, dialing, etc.). 

Bytes:  The Bytes field displays the number of bytes received from the remote site.  The received bytes can be 

data or error message information from the remote station. 

Port Status:  The Port Status field displays the state of the COM port during the call.  This field is only used when 

communication is through a telephone modem. 

Data Status:  The Data Status field displays the state of the data received from the remote site.  One of three 

messages is displayed in this field (see below).   

Good : Data was successfully retrieved from the remote station. 

None : No data was received. 

Invalid : The returned bytes did not contain valid station data. 
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4.2.2 History Tab 

The History tab shows the status of all station calls (manual and automatic).  The History tab has several filters 

which enable the user to selectively view station call information.  After entering the desired filter information 

the StreamTrac will update the History screen after approximately 2 seconds or the user can immediately 

manually update the screen by clicking either of the refresh icons   

 
Figure 4-8:  Call Status History Tab 

In addition to filtering the station call information, the information can be sorted by clicking on any of the 

History tab Field Headings.   

 Call Information Filters 4.2.2.1

Six filters are available to allow the user to selectively view call information.  The filters work in conjunction with 

each other, only calls which match all filter requirements will be displayed.  If a filter is left blank, it will be 

ignored in the sorting criteria.   

Call Date Range Filter:  this filter allows the user to select the date range of the calls that the user wishes to 

examine.  This filter requires that a start and end date be specified (note that the end date can be in the 

future). 

Station Name Filter:  this filter allows the user to select which station(s) calls appear in the History tab.  The 

Station Name filter can be a partial string so that stations with similar names can be displayed at the same 

time. 

Group Name Filter:  this filter allows the user to select which station group(s) calls appear in the History tab.  

Like the Station Name filter, the Group Name filter can be a partial string so that station groups with similar 

names can be displayed at the same time. 

Source Filter:  this filter allows the user to select whether to display manually generated calls (StreamTrac) or 

scheduled calls (AutoCaller Service) in the History tab.  If this filter is left blank, both manual and scheduled 

calls will be displayed. 

Call Details Filter:  this filter allows the user to isolate the details of the calls that are displayed.  For example, 

the user could choose to display only calls on a certain COM port or calls to a certain telephone number.   

Error Details Filter:  this filter allows the user to only display calls with certain errors.  For example, the user 

could choose to display all calls that required more than 1 attempt.   
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 History Fields 4.2.2.2

The History tab has several fields to accurately report the status of each station call.  Many of the fields contain 

the same information as the Current Status tab; however, the History tab does have additional fields.  Fields in 

the History tab may be rearranged (drag and drop the Field Heading) to suit specific needs.  An explanation of 

each Field Heading follows. 

Track #:  The Track # field displays a reference number unique to the method in which the call was made 

(manual call via StreamTrac or scheduled call via the AutoCaller Service).  This reference number is the same 

as the number shown in the Reference field of the Current Status tab. 

Source:  Like the Reference field on the Current Status tab, the Source field displays the originator of the call; 

either the Calling Service (displayed as AutoCaller Service) or StreamTrac.   

Request Date/Time:  The Request Date/Time field displays the date and time the call was placed into the 

calling queue.  This field is the same as the Date/Time Field on the Current Status tab. 

Station Name:  The Station field displays the name of the station being called.  This field displays the station 

name portion of the Group/Station Field on the Current Status tab. 

Group Name:  The Group field displays the group of the station being called.  This field displays the group name 

portion of the Group/Station Field on the Current Status tab. 

Comm Type:  This field is the same as the Comm Type Field on the Current Status tab. 

Call Type:  This field is the same as the Call Type Field on the Current Status tab. 

Call Details:  This field is the same as the Call Details Field on the Current Status tab. 

Call Status:  This field is the same as the Call Status Field on the Current Status tab. 

Call Progress:  This field is the same as the Call Progress Field on the Current Status tab. 

Bytes:  This field is the same as the Bytes Field on the Current Status tab. 

Port Status:  This field is the same as the Port Status Field on the Current Status tab. 

Error Details:  The Error Details field displays specifics errors that occurred during the call process.  If the call 

has multiple retries then successive error messages are appended and displayed in this field.  This means 

that even though a call retry successfully retrieves data, the Error Details field will still display an error 

message from the previously failed call attempt.  This information is repeated in the Error Details box at the 

bottom of the screen. 

Attempt #:  The Attempt # field displays a count for the number of attempts made to collect the data.  This field 

is useful for identifying stations whose communications may be problematic (i.e., perhaps a poor radio link 

or telephone line).      

Max Attempts:  The Max Attempts field displays the number of attempts allowable to collect the data.  This 

field identifies how many retries are allowed for a specific station call (i.e., if a call is allowed 2 retry attempts 

then the Max Attempts field will display 3 – one original call plus 2 additional retries in the event of 

communication failures).      

Actual Port Used:  The Actual Port Used field displays the actual COM port used for the station 

communications.  This field is useful when the user has a pool of modems that can be used to call stations as 

it identifies which COM port was used to make the station call.      
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Call Start Date/Time:  The Call Start Date/Time field displays the date and time the station calling process was 

actually started.  

Call End Date/Time:  The Call End Date/Time field displays the date and time the call to the station was 

completed.  

Data Status:  This field is the same as the Data Status Field on the Current Status tab. 

Origin PC:  This field provides information on which PC originated the call. 

User Name:  This field provides information on which user originated the call. 
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4.3 DATA>VIEW/EDIT MENU 

The View/Edit menu allows users to examine and edit the data retrieved from remote monitoring stations.  The 

View/Edit window is used to select a station from the Select Station pull-down list.  The data will be displayed in 

tabular form (with rows and columns).  The date and times are displayed down the left side of the screen and the 

abbreviated data field names are across the top.   

The displayed data can be filtered using specific data fields and operators, or by using a variety of chronological 

filters.  After selecting a desired data range and/or setting a data field filter, the data should updated by using 

either of the screen’s Refresh icons .   

Additionally, a series of Action Buttons enables common actions to be initiated or modified from this screen (ie: 

running/modifying calculations or adding/clearing forecasted data)  

 
Figure 4-9:  View Data Screen 

The data will appear in a variety of colours indicating the state of the data (normal, changed, editing, deleted, 

selected, raw, or forecast).  The colour code can be viewed by selecting the Colours button at the bottom right 

corner or to bring up the Column Control Panel (see the following section).   

The fields with the _Raw suffix whose data values appear in red are locked in the database and cannot be 

changed. They are retained as a record of the original data from the data logger.  All other values can be edited 

by clicking in the field then entering a new value.   

In addition to editing the data colours, the Data Table can be manipulated to suit individual requirements (see 

Figure 4-10).  Column locations can be re-arranged by dragging the column headings and dropping them in the 

desired location in the table.  This can also be done by using the Column Control Panel (see the following 

section).   

Action Buttons 

Data Field Filter  

Chronological Filter 
B 
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Normally data is displayed in descending chronological order; however, the data can be sorted by clicking on 

any data field heading on the Data View screen and using the up or down arrow beside the data field heading to 

toggle between ascending or descending order.  

Regions can be selected by clicking and dragging the mouse over a region or by using the Column Control Panel 

(see the following section).  Only single columns or regions within a single column can be selected. Once a 

region is selected the data can be copied or cut and pasted into a different column by right clicking and using 

the Column Control Panel (see the following section). 

 
Figure 4-10:  Sorting Data 

4.3.1 Data Field Filter 

The Data Field filter allows the user to further refine the station data that is displayed. The Data Field filter is a 

simple filter as it only filters based on one data condition on one station data field.   

Field:  this drop-down selection box selects which one of the station’s data fields will be used as the filter.   

Operator:  this drop-down selection box selects the action to perform on the data field.  The available 

mathematical operator choices are: 

 equal to (=) 

 less than (<) 

 less than or equal to (<=) 

 greater than (>) 

 greater than or equal to (>=) 

Value:  this entry box allows the user to enter a number to set the desired filter value. 

Clear Filter: this icon    deletes the data filter settings to allow all data to be displayed.  

 

Change the order of 
the columns by 

dragging to a new 
location 

Click on any column 
heading to sort by 
that field in ascending 
or descending order 

Data colour indicates 
data states  
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4.3.2 Chronological Filter 

Station data can be viewed in one of two ways: by specifying a specific date and time range, or by selecting a 

more general “floating” range from a drop down menu.    

Range 

The Range button enables the From and To selection boxes so that specific dates and times can be selected.  

Dates are selected by left clicking on the month, day or year portion of the date, and then using the up and 

down arrows to select the desired number.  Right clicking in either selection box will provide a drop down menu 

with the following automatic date selection options: Today, First Date in File, Last Date in File, and Beginning of 

Month. 

Note the dates are displayed in month/day/year format, and times are displayed using the 24 hour clock. 

 
Figure 4-11: Range date selection 

Float 

The Float button enables the View selection box with specific time periods in a drop down menu.  The user may 

input a period of their choosing (i.e., Last 65 days, Last 6 hours). 

 

 
Figure 4-12:  Float Time Options 

Times in View 

The Times in View drop down selection box is used to select which data from the database to view.  The user 

may select from the dropdown choices or can modify one of the choices so that only the desired data is 

displayed.  

 

  
Figure 4-13: Times in View 
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There are nine drop down menu items: 

 

 ALL  Will display all times of day 

 0..23  Displays only hourly data from midnight until 11 p.m. (23:00) 

 12:00  Displays only noon data 

 13  Displays only 1 p.m. data (13:00 on the 24 hour clock) 

 1,3,5,7  Displays only hours 1 a.m., 3 a.m., 5 a.m., and 7 a.m. 

 7  Displays only 7 a.m. data 

 Hourly  Displays only hourly data for each of 24 hrs 

 30 Min  Displays will be every thirty minutes starting on the hour 

 15 Min  Displays will be every fifteen minutes starting on the hour 

To input a customized time remember that times use the 24 hour clock.  Also, a specific time can be viewed by 

placing a colon in the format (i.e.  08:30 will view only 8:30 a.m. data).  

Show Gaps 

The Show Gaps checkbox enables visual markers in the station’s data which indicate that there is data missing (a 

gap) between two data points.  StreamTrac determines if there is a data gap by examining the data point time 

interval.  In the example, the data is on a 10 minute interval and StreamTrac has indicated the gap where the 

20:00:00 data should have appeared with a thick blue line and annotated it with the word GAP. 

 

 
Figure 4-14: GAP indicator 
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4.3.3 Action Buttons 

There are several Action Buttons at the bottom right corner of the screen which can be used to edit the screen 

appearance, perform and edit calculations, and view and print data.  

Save Edits: any editing to the data table which was undertaken will be saved by selecting this button.  

Run Calculations:  selecting this will run any calculations which have been setup using the STATIONS> STATION 

SETUP> CALCULATIONS . 

Modify Calculations: selecting this icon    displays the calculations for the current station. The Calculations 

Screen can also be reached from the Station Admin screen via the Stations>Station Setup>Calculations tab. 

Print Data: selecting this icon    prints the data as it is displayed on the View Data screen. 

Print Preview:  selecting this icon   displays how the data will be printed.  

 

Colours 

The data will appear in a variety of colours indicating the state of the data (normal, changed, editing, deleted, 

selected, raw, or forecast).  The colour code can be viewed by selecting the Colours button at the bottom right 

corner to display the Set View/Edit Colour window or right clicking to bring up the Column Control Panel (see 

the following section).  Clicking on a particular square will display a Color chart which can be used to customize 

the colour selections. 

Note that the default colours for Raw and Normal values (red and black respectively) cannot be edited. 

 
Figure 4-15:  Data Colours  

 

  



StreamTrac  

700-ST-MAN  Rev. 2 -  29 Oct 2015  Page 68/155 

4.3.4 Forecast 

StreamTrac will allow you to enter estimated forecast data for a maximum of 72 hours into the future.  Select the 

desired forecast Start and End date and times.   

Forecasted data will be overwritten as new real data is collected with no record kept of the forecasted data. 

 

 
Figure 4-16: Create Forecast Data screen 

Data Interval:  Input the desired data interval 

 

Fill Style:  Select the Fill Style from the two options: 

 1) Fill With Historical Data:  this option will automatically fill the future records from the most  

  recent data from the past; 

 

 2) Fill with Blanks:  this option provides blank records which can be filled in manually  

Forecasting can also be done using the Column Control Panel.  See the Column Control Panel section for details. 

 

4.3.5 Column Control Panel 

In addition to the filters and display manipulation discussed previously, the Column Control Panel provides a 

drop down menu of a variety of options to customize how the station’s data is displayed or edited.  To display 

the Column Control Panel, right click on the Data Table.  The options included in this panel include: 

1) selecting which sensor’s data to view; 

2) editing data; and  

3) launching select Station Admin menus. 
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Figure 4-17: Column Control Panel 

 

4.3.6 Data View Options 

Data Columns can be displayed or hidden by right-clicking within the column to display the column control 

panel.  Selecting Hide Field will remove that column from the display.   

To hide or display several data fields, select Hide and Show Fields.  A detailed Manage Data Columns will appear.  

 

 
Figure 4-18:  Manage Data Columns Menu 

Move a field between the two columns by selecting it (it will be highlighted in blue) and using the move left (<) 

and move right (>) arrows accordingly.   The Move all (>>) arrows will move all field from the Hidden Columns 

to the Displayed Columns.  Several fields can be selected by holding the mouse down and dragging it over the 

selections. 

To re-order columns, first select the field or group of fields you wish to move then click the up arrow to move 

them up in the list or down arrow to move the fields down in the list. The top field will be the left most field 

Data View Options 

Data Edit Options 

Station Admin Menus 
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displayed in the View/Edit screen.  Clicking OK will save any changes you have made. If you do not wish to save 

your changes click Cancel instead. 

Raw Fields can be hidden or displayed by selecting the Raw Fields drop down menus.  Select Hide Raw Fields or 

Show Raw Fields as desired.  

 

4.3.7 Data Editing Options 

The Data Edit options on the Column Control Panel provide a means of selecting, deleting, copying, and cutting 

and pasting data.  Move the cursor over the desired field and right click.  The field will be highlighted in blue and 

the Column Control Panel will be displayed.  Left click on the desired edit option in the Column Control Panel 

then right click on the field to be edited.  Left click on the desired edit option from the Column Control Panel to 

complete the action.  

Use the Set Colours menu item to customize the data colours.  See the previous Action Buttons – Colours 

section. 
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4.4 DATA>SHOW INFO CALL MENU 

The Information Call Results window displays the information returned from station information calls.  

Information returned from a Current Conditions, Logger Information, or Special Call is displayed as the data is 

retrieved and will remain displayed until information from subsequent calls ‘pushes’ the older data off the 

bottom of the window.  The user can clear the Information Call Results window by pressing the Clear button at 

the bottom of the window. 

Information made from these calls is not stored in the database. 

          

Figure 4-19: Examples of Different Information Call Results Displays 

Clear: this icon    clears the Information Call Results window.  No station data is deleted during this 

operation, only the information on the display is cleared. 
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4.5 DATA>IMPORT MENU 

The Import Data menu permits the importation into the StreamTrac database of additional data from CSV, Text, 

and Campbell Scientific formats.  To import data it is necessary to create a template which contains information 

on what fields are to be imported and how the import is to be done. 

4.5.1 Creating an Import Template – CSV and Text 

Selecting Data>Import>CSV & Text will display the Import Template menu.  Use the drop down menu to select 

the Target Station (Step 1).  This is the Station’s name in the database to which the data will be imported.  Use 

the Browse button to select the file for importation (Step 2). 

 

 
Figure 4-20: Import CSV Template 

Source File Type:  After selecting a source file, use the Source File Type drop down menu to select the 

appropriate source file type.   

 

 
Figure 4-21: Source File Type drop down menu 
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There are four choices:  

Character Delimited Text:  Columns are separated by a specified character.  Note: In some cases, you may have 

to change the character the program uses to identify column separations (i.e. from comma to asterisk).  This 

is done using the Delimiter drop down menu to the right of the data column window. 

 
Figure 4-22: Delimiter drop down menu 

Column Oriented Text:  Column widths are defined by manipulating the column control in the "Map data 

columns to station fields" table. 

CSV Text:  Comma Separated Variable. This is the same format StreamTrac exports into, it is very straightforward 

to setup for data import. 

Campbell: See Campbell Scientific section below. 

 Mapping the Fields 4.5.1.1

The data fields to be imported are mapped using the following procedure.   

Right-click on each column of data in the Field Definitions window and select a field from the station’s shell 

records using the drop down menu.  If applicable, the field units should also be selected.  

  
Figure 4-23:  Import Template dialog 

 



StreamTrac  

700-ST-MAN  Rev. 2 -  29 Oct 2015  Page 74/155 

In the event that the import data has a field which does not exist in the selected station’s shell records, it can be 

added directly by clicking on the Add Field button.  There is no need to modify that station using the Stations 

Menu. 

 Formatting Date/Time 4.5.1.2

Any chronological field selected must be formatted for the date and time.  Use the drop down Field Format 

menu and select the desired format. 

 
Figure 4-24: Date-Time Formats 

Default time checkbox:   when the records contain only dates and no time, this can be selected and a 

default time input.  In such a case the data will be time stamped with the date and default time when 

it is saved to the database.  

Overwrite Raw Data:  when selected, any raw data will be overwritten 

View Log:  selecting this will display the Import History Log.  The Import History Log is a record of events and 

errors which occurred when importing data  

Run: once the template is complete, selecting this will import the data  

Save Template: saves the template to a source file 

Delete: deletes the template from the source file 

Close: closes the template.   

4.5.2 Creating an Import Template – Campbell Scientific (1) 

There are two ways to create an Import Template for Campbell Scientific data files. Steps 1 and 2 are 

completed the same as for a CSV and Text Template.  However, once Campbell is selected from the 

Source File Type drop down menu, Step 3 is replaced with the Campbell Field Arrays box. 

 
Figure 4-25: Campbell Scientific Import Template 
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Any number of Field arrays can be defined using the Insert Array button and will appear as tabs at the 

top of the section.   

 
Figure 4-26: Field Array Tabs 

Insert Array:  select this to add a Field Array.  Follow the prompt to name it.  The Year, Day of Year, and Time 

fields and their formats are automatically entered. 

Delete Array: use this to delete an array.  Ensure you have selected the click on the tab of the desired array, and 

then select Delete Array 

Modify Name:  use this to change the name of an array 

Use FSL:  the FSL (Final Storage Label) is a Campbell Scientific template which can be copied (template) to the 

array.  It will overwrite the template.  Follow the prompts to browse for the FSL. 

 ADDING AN FTS FIELD  4.5.2.1

To add a field, left click in the FTS column and use the drop down menu to select a field.  Note that the drop 

down arrow is offset to the right from the associated field.  

 

 
Figure 4-27: Adding an FTS Field 

 CAMPBELL FIELD  4.5.2.2

The associated Campbell Field name which matches the FTS Field name must be manually inserted in this 

column. 
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 FORMAT 4.5.2.3

The format field can be left blank in which case all of the decimals in the number will be imported.  The number 

of decimals can be limited by the format strings consisting of the letter “d” mirroring the desired format of the 

number.  For example dddd.dd will limit the size of the number to 4 digits with 2 decimal places. 

 UNITS 4.5.2.4

Left clicking in this column will bring up a drop down menu arrow (offset one column width to the right).  Make 

a selection form this list or type in units which do not appear in the list. 

 

 CALCULATION 4.5.2.5

Selecting a space in the Calculation column will display the Calculation Editor.  This can be used to perform basic 

calculations using the data in that field. 

 

 
Figure 4-28: Calculation Editor 

4.5.3 Creating An Import Template – Campbell Scientific (2) 

The second way to create a Campbell Scientific template is to select  DATA>IMPORT>CAMPBELL.  The following 

import wizard specially designed to deal with Campbell Scientific data files will be displayed.  

 

 
Figure 4-29: Campbell Import screen 
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First a source file from which to import from must be selected. Use the Browse button to browse to the 

file's location, select the file, and click Open. 

Next, select the station to receive the imported data using the drop down menu. 

To set up the import template, the different arrays in the Campbell Scientific data files must be 

identified by using the array tags.  Care must be taken to ensure the correct array tag is identified and 

to distinguish the data in each array for some arrays, although similar, may not be exactly the same. 

Array#:  this must be filled with the identifying number for each data array on the Campbell file.  

Year, DayNum, Time,: these fields are automatically entered 

Blank Fields:  fields which are meant to come after the Year,DayNum,Time, fields must be manually 

input.  This is done by typing the exact name of the field (for the station being imported to) that 

the data will be entered into followed by a comma.  There are no spaces between data field names 

and commas. 

Important Note: If there is a field in the source file you would like to skip, you must still enter a 

comma, but do not enter a field name.  

Example: Year,DayNum,Time,Stage,Turbidity,,Pressure 

 This would enter data from the first five columns of the Campbell Scientific file into the fields 

Year, DayNum, Time, Stage and Turbidity, but would skip the sixth column and enter data from 

the seventh into the Pressure field. 
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4.6 DATA>EXPORT MENU 

The Export Data menu allows the users to export your station or group of stations to CSV or XML files. 

Furthermore, these exports can be performed on an un-attended scheduled basis using the 

FTSExporter service.  The basis of the export system is the “Export Template” which is a way to define 

and then save an export definition for later use by the user or to be used by the export schedule 

service to perform un-attended exports. 

 

4.6.1 Manage Existing Export Templates 

Selecting Data>Export will display the “Export Template” screen which is used to define and save an 

export definition for later use either by the user or to be used by the export schedule service to 

perform un-attended exports. 

 

Figure 4-30:  Export Templates Screen 

From this screen, existing templates can be viewed, edited and deleted, and new templates can be created.  The 

existing templates can be sorted by double clicking on the header to change from descending to ascending 

order, and vice versa. 

To view and edit an existing template, double click on it.  To create a new template, select the New button. 

The templates can be filtered by Owner, Last Saved Data and Export Type.  The filter will refresh in about 2 

seconds after the last keystroke. 

  

Filters 

Existing Templates 
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4.6.2 View/Edit/Create Export Templates 

Double clicking on an existing template or selecting the New button will display the Export Template 

screen.   

 

 

Figure 4-31:  Export Template Settings 

 Settings Tab 4.6.2.1

Export Stations or Groups: use the radio buttons to select the desired option.  The appropriate Choose Stations 

or Choose Calling Groups will become active.  Select which station(s) or group(s) to export. 

Note: The selection made here will determine what fields are available in the All Chosen Station’s Fields box 

below.  Failing to choose a station or group will result in an empty box. 

OUTPUT FORMAT 

All Chosen Station’s Fields:  The box will contain all the available fields within the selected stations or groups. 

Fields that are not a part of the station choices will not appear here.  Move items between the All Chosen 

Fields column and the Chosen Fields column by clicking on the desired field then using the left and right 

arrows as appropriate.  

Chosen Fields:  The fields in this box are the only data fields that will be exported.  They will be exported in the 

order that they appear from top to bottom and appear from left to right in the CSV data file.  All fields will 

remain in the same column number. Therefore, if a field is not valid for one of the chosen stations, then an 

empty cell will appear on that station’s line in place of that field.  This rule will maintain CSV column integrity 

while allowing multiple stations to be exported to a single file. 

Note: The first two columns of all CSV exports will be the station name followed by a comma then the date and 

time value for each record.  
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Output Types:   Use the drop down menu to select either CSV, XML, or XML Custom for the data output. 

A)  CSV (Comma Spaced Variable) is defined as a single line for each data record with each field on 

the line separated by commas. Output lines will contain a mandatory station name field followed by 

a date-time as the first two columns, then followed by each of the selected fields in the order as they 

appear (top to bottom) in the chosen fields box. 

 B)  XML output is a fixed format where all fields for each record contain a field name tag.  Every 

 selected record will appear but empty fields for each record will not.. Example: 

 

 

 

 

 

 

 

 XML output will also create an XML Schema file with the same name as the output file with 

 the extension “XSD” 

 C)  XML Custom is a specific XML format designed to meet the particular needs of a limited user 

 group.  An example of its format follows. 

 

  <?xml version="1.0" encoding="UTF-8" ?>  
- <dataroot xmlns:od="urn:schemas-microsoft-com:officedata" xmlns:xsi="http://www.w3.org/2001/XMLSchema-

instance" xsi:noNamespaceSchemaLocation="TestXML.xsd" generated="2008-06-25T09:10:22"> 
- <FTS_Rooftop_async> 

  <DateTimeNum>2008-04-24T10:40:00</DateTimeNum>  
  <ATC>11.2</ATC>  
  <LoggerSn>1006</LoggerSn>  
  <Telem>14</Telem>  
  <ATC_Raw_>11.2</ATC_Raw_>  
  <Telem_Raw_>14</Telem_Raw_>  

  </FTS_Rooftop_async> 
- <FTS_Rooftop_async> 

  <DateTimeNum>2008-04-24T10:50:00</DateTimeNum>  
  <ATC>11.3</ATC>  
  <LoggerSn>1006</LoggerSn>  
  <Telem>13.9</Telem>  
  <ATC_Raw_>11.3</ATC_Raw_>  
  <Telem_Raw_>13.9</Telem_Raw_>  

  </FTS_Rooftop_async> 
- <FTS_Rooftop_async> 

 

file:///C:/FTSAutoCallerExport%2522
file:///C:/FTSAutoCallerExport%2522
file:///C:/FTSAutoCallerExport%2522
file:///C:/FTSAutoCallerExport%2522
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Missing Value Substitute:  This field is only relevant to CSV files. Input the desired character to be used to 

indicate a missing value.  If left blank a missing character will be indicated by two commas in succession. 

 

Date Time Format:  This box determines how the date-time is formatted to the CSV file (date-time always starts 

at the second column of the CSV).  Use the drop down menu to select from the standard formats or type 

directly into the text area of the box to create unique date and time formats. Placing commas between the 

date and time characters will cause them to be placed into separate columns in the CSV.  For example: 

 Example # Date-Time Mask CSV Output Example 

 1  yyyy/mm/dd hh:mm:ss StationName,2008/06/20 09:45:00,data1,data2 ….. 

 2  mm dd yyyy hh:mm:ss StationName,Jun 20 2008 09:45:00,data1,data2 ….. 

 3  mm dd yyy, hh:mm:ss StationName,Jun 20 2008,09:45:00,data1,data2 …..  

 4         yy,mm,dd,hh:mm StationName,08,06,20,09:45,data1,data2 …..  

Times Box:  The purpose of this box is to filter the data records based on time of day.  Only records that meet 

these criteria will be exported.  There are nine selections in the drop down menu, or a custom time selection 

can be typed in the box. Note that times reflect the 24 hour clock.  For a specific time, type the complete 

time in using a colon (i.e. 16:40).  

 The Drop down selections are: 

 ALL  Will display all data recorded at times 

 0..23  Exports only hourly data for each of 24 hours 

 12:00  Exports only noon data 

 13  Exports only 13:00 (1 p. m.) data 

 1,3,5,7  Exports only hours 1 a.m., 3 a.m., 5 a.m., and 7 a.m. 

 7  Exports only 7 a.m. data 

 Hourly  Exports only hourly data for each of 24 hrs 

 30 Min  Exports will be every thirty minutes starting on the hour  

 15 Min  Exports will be every fifteen minutes starting on the hour 

 

Include Field Labels:  When ticked, causes the first line of the CSV export to contain the field labels for each of 

the fields to be exported. It has no effect on XML output format. 

Include Field Units:  When ticked, causes the second line of the CSV export to contain the field units each of the 

fields.  It has no effect on XML output format 

Include Forecast Data:  When ticked, will include the forecast data in the CSV export It has no effect on XML 

output format 

 

 Schedule Tab 4.6.2.2

Export templates can be scheduled to run at pre-selected times in an un-attended mode by completing the 

schedule tab of the export template. 
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Figure 4-32:  Export Templates Schedule 

IMPORTANT! The Enable Scheduled Data Collection checkbox must be selected in 

order to allow the Exporting Service to use this template to export data. 

Use Fixed Schedule:  This checkbox must be selected in order to specify periodic exporting times.  The Fixed 

Schedule is a daily schedule whose cycle restarts at midnight (local) each day.   

Use the drop down menus to set how often data is exported, the units of time, and the time bracket.  Note 

the time brackets use the 24 hour clock and are in hh:mm:ss format. 

In Figure 4-32 the defined Fixed Schedule will cause the Calling Service to call the Demo 1 station hourly 

starting at 00:01 (12:01am) until 21:01 (9:01 pm) each day. 

Other Daily Times:  This line is used to specify daily non-periodic exporting times.  In Figure 4-32, the defined 

Other Daily Times will cause the exporting Service to run this template at 04:30 (4:30 am), 12:00 (noon), 

18:30 (6:30 p.m.), and 22:30 (10:30 p.m.) each day in addition to the periodic call times defined by the Fixed 

Schedule.  Other Times should be entered in 24 hour format (hh:mm) with a space between the different call 

times. 
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4.7 DATA>DATA TRANSFER MENU 

The  DATA > DATA TRANSFER  function permits the transfer of self-contained, compacted files which contain 

one or more entire stations information including data and meta data such as field names and units.  It has two 

parts: Create Data Transfer File and Load Data Transfer File. 

 

Figure 4-33:  Data Transfer Menu 

4.7.1 Create Data Transfer File 

The Create Data Transfer File creates self-contained, compacted files which contain one or more entire stations 

information including data and meta data such as field names and units.  This file can then be sent to other 

offices to load the contained stations into their own databases using the Load Data Transfer File function. 

 

Figure 4-34:  Creating a Data Transfer File 

Select Stations To Transfer:  Place a check beside all the stations to be exported.  The choices will be placed 

into a single data transfer file together with the data range chosen and all metadata such as field names and 

units. 

Save Options:   This option determines the amount of data to transfer by providing three available data range 

options: 

 1) Since Last: will keep track by station as to the last transfer data date and time so that the next  

   data transfer will begin at that point;  

 2) Date Range:  allows a specific start and end date time to transfer using the drop down menus; and 

 3) All Data:  exports all the data for each of the stations chosen. 
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Include Forecast Data:  Select this box to have forecasted data included in the data transfer. 

Target Transfer File Name:  Identify a file into which to transfer the data.  Click the Browse button and choose a 

path and file name.  You cannot type directly into the file box nor can you change the extension of the file.  

The file must remain as .DTZ in order for the recipient’s Data Transfer Load Function to recognize it. 

 

Select Save and then Close. 

4.7.2 Load from Data Transfer File 

The Load Data From Transfer File function enables a Data Transfer File (.dtz) sent from another source using 

the Create Data Transfer File function to be opened and loaded.  This is a self-contained compacted file which 

can contain one or more entire stations information including data and meta data such as field names, units etc.. 

 

 
Figure 4-35:  Load Data from Transfer File 

Choose a Data Transfer File:  Data transfer files will be appended by .dtz.  Browse to the desired .dtz file and 

click open.  A list of Available Stations will appear in the Select From Available Station In Transfer box as 

shown in Figure 4-35.  

 

Select From Available Station to Transfer:   Tick one or more of the listed stations to load into the database. 

They can be loaded with the listed station names or they can be re-named by using the Map Transferred 

Station function described below.  Stations that do not exist in the receiving database will be created using 

the name in the Available Station In Transfer list.  

4.7.3 Map Transferred Stations 

This function will transfer the data from the selected Available Station to a differently named local station.  If the 

receiving office has different naming conventions than the sending office, there is a danger that different 

stations may have the same name.  This function prevents overwriting an existing station’s data with the data 

being transferred.   

To map an Available Station to a differently named local station, first select it from the Available Station to 

Transfer box (it will be highlighted in blue).  Use the Change Local Target Station drop down menu to select the 

desired Local Target Station.  Once selected, that station’s name will populate the Local Target Station field.  This 

can be done for any number of Available Stations.   

The Data Start Date-Time and Data End Date-Time are for information purposes and will display the range of 

data in the chosen transfer file. 
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4.7.4 Load Data Options 

Add Only New Records:  This option is to load records that do not exist in the target station and will not 

overwrite any existing records even though they are part of the sent data. 

Overwrite All Records:  This option will replace all of the target station records with those from the transfer file. 

Import All Data:  This option will import both the field (user) data as well as the raw data to the target station. 

Import Only Raw Data:  This option will import only the Raw copy of the data leaving the target station’s field 

(user) data un-touched. 

Import Only User Data:  This option will import only the User copy of the data leaving the Raw data un-

touched. 

 

Run Transfer on Selected Stations 

Once all the options have been selected, click the Run Transfer on Selected Stations button to complete the 

data transfer. 
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4.8 DATA>DATA ALARMS MENU 

The Data Alarms interface allows you to create and view trigger conditions and manage contacts for alarms 

generated by the trigger conditions.  To access the Data Alarms Module, select Data> Data Alarms.  A list of 

existing alarms will be displayed or the screen will be blank if no alarms have been created 

NOTE: The Data Alarm service must be installed for alarms to be functional. Alarms can 

be edited without the service, however no messages will be sent. 

To access the Data Alarms Module, select Data from the main Menu Bar, then Data Alarms. A list of existing 

alarms will be presented. 

 
Figure 4-36:  Data Alarms Screen 

 

 

Every time StreamTrac is opened, a Data Alarm Warning screen will appear if there have been any newly 

triggered alarms.  

 

 
Figure 4-37:  Data Alarm Warning Screen 
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4.8.1 View Existing Alarms 

From the Data Alarm summary page existing alarms can be viewed and sorted.  Double clicking on an existing 

alarm will open the Create/Edit Alarm page with that alarm loaded.  Any modifications to the alarm can be 

made on this page (refer to the Creating/Editing alarms section for details).  

Existing alarms can be filtered by station name, field, or whether the alarm is On/Off (whether the Alarm On box 

is enabled or not in the Create/Edit Alarm page – see the following section).  Select the desired filters.  The screen 

will automatically update with the filters in place.  

To delete an alarm first select the alarm then click on the Delete Alarm button. 

 

4.8.2 Creating/Editing Alarms 

To create or edit an alarm either click the New Alarm button or double click on the existing alarm in the Alarm 

summary tab. 

 
Figure 4-38:  Creating an Alarm 

When creating a new alarm first select the Station Name then select the field using the drop down menus.  A 

short description of the alarm can be typed in the Description field.  

The Alarm can be enabled or disabled as a whole using the Alarm On check box. 

 Alarm Triggers 4.8.2.1

Triggers can then be set up for the selected field.  Individual triggers can be turned on or off using the On/Off 

check box that corresponds with the trigger.  However, if the Alarm On checkbox, described above, is not 

selected any Alarm Triggers that are On will not trigger an alarm.  

Tiered Alarm Triggers (Low, Medium, High) are checked from high down to low.  A high alarm takes 

precedence over a medium or low alarm and a medium alarm takes precedence over a low alarm.  Tiered alarms 

can be triggered either when the value is greater than the trigger or when the value is less than the trigger.  This 

can be set using the "Trigger tiered alarm when:" radio box selection. 
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The Change Alarm denoted by "Change of  #  Over  # Intervals" is triggered when an absolute change of at 

least the change amount occurs over the specified number of intervals.  

FTS Error Code: this is a text message which will be displayed when an FTS Error code is encountered in the 

data.   

 Some examples of FTS Error Messages: 

  Bad response from sensor  Over range value returned 

  Missing sensor    Floating point 

  Sensor error    No Data 

     

 

User Defined Error Code:  this is used to input a specific value that will trigger an alarm along with a 

description. 

Maximum Notify Frequency Setting:  this controls how often a Data Alarm is re-triggered.   

 For example: if a high alarm is triggered and the Maximum Notify Frequency is set to 24 Hours then  another 

high alarm will not be triggered for at least 24 hours. A custom notification frequency can be set for each 

alarm using the Use Custom setting.  The Global notify frequency can be changed in the Settings>Global 

Settings screen. 

Last Notification sent:  this displays the time the last notification was sent. 

4.8.3 Contact Tab 

The Contact tab of the Create/Edit Alarm interface is used to assign who receives alarms for a particular station. 

Contacts exist on a per station basis (i.e. a contact for 'Station Demo' will receive all alarms generated for that 

station). 

 

 
Figure 4-39:  Alarm Contact Tab 

New contacts can be added by clicking the New Contact button and entering the required information. To 

delete a contact either highlight select the contact and press the Delete Contact button or right click on the 

contact and select Delete Contact.  To edit an existing contact simply double click on the contact you wish to 

change. 



StreamTrac  

700-ST-MAN  Rev. 2 -  29 Oct 2015  Page 89/155 

4.8.4 Alarm History  

The History page (Data>Data Alarms>History) will list all the alarms which have been triggered and sent.  The list 

can be filtered by date, station, field type, and alarm trigger.  Once a filter has been input, use either of the 

refresh icons to update the screen.  To clear a filter, highlight it and select the Erase button.  

 
Figure 4-40:  Alarm History Tab 
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4.9 DATA>DASHBOARDS 

The Dashboard screen feature will provide up to the minute weather information on the selected stations.  As 

data is collected, the dashboard will automatically update the selected data fields as well as update the chosen 

fields on the graph.  The dashboard is designed to report on a single station; however, the line graph section will 

allow multiple stations to be plotted on a single dashboard for comparison purposes. 

 

 

 
Figure 4-41:  Dashboard Screen 

Current Station Field Values:  this portion provides single values for the selected station including Air 

Temperature, Precipitation, Humidity, Soil Temperature, Atmospheric Pressure, and Solar Radiation. 

Wind Rose:  this chart provides a visual analysis of the Wind Speed and Direction using colour coded wind 

speed bins.   

Wind Speed and Direction Dials:   The Wind Speed and Direction Dials provide a quick visual reference for the 

most recently logged Wind Speed and Direction  

Multi-Station Line Graph:  This graph provides a line graph of the current weather information.  Several 

stations and fields can be plotted together.  The point readouts will be displayed by hovering the cursor 

over the points 

 

Current Station Field Values 

Wind Rose 

Wind Speed and Direction Dials 

Multi-Station Line Graph 
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4.9.1 Creating a Dashboard 

To create a dashboard, select New to display the New Dashboard screen.  The Display tab will be blank until the 

dashboard is defined using the Settings Tab.  Click on the Settings Tab. 

 

 
Figure 4-42:  Creating a Dashboard 

4.9.2 Defining the Settings 

The Settings tab provides the fields that will be used to define the dashboard display.   It has four sections: 

General Settings, Field Name Mapping, Windrose Settings, and Line Graph Settings.   

 
Figure 4-43:  Dashboard Settings 
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GENERAL SETTINGS  

Description:  this section must be filled with a descriptive name for the dashboard 

Station:  use the drop down menu to determine the station for which the dashboard will be developed 

Report Days:  input the number of days of data which will be collected and displayed on the dashboard.   

 

FIELD NAME MAPPING 

Determine which fields are to display data and use the drop down menu to select a field name.  Only those field 

names available to the selected station will appear in the menu.  To delete a field name click on it (it will be 

highlighted in blue) and select delete on the keyboard. 

 

 

WINDROSE SETTINGS  

Number of Directions:  this determines how many radial arms and the respective true bearings will be marked 

on the compass rose:  eight (8) will be every 45 degrees, 16 will be every 22.5 degrees, and 36 will be every 

10 degrees. 

Times in View:  this will determine which data from the database will be displayed.  Times reflect the 24 hour 

clock and the menu can be customized by typing specific time requirements in the field following the 

format of the drop down menu examples.  The drop down menu consists of the following nine selections:   

 

 ALL  Will display all data logged throughout the day 

 0..23  Displays only hourly data for each of 24 hours 

 12:00  Displays only noon data 

 13  Displays only 13:00 (1 p.m.) data 

 1,3,5,7  Displays only hours 1 a.m., 3 a.m., 5 a.m., and 7 a.m. data 

 7  Displays only 7 a.m. 

 Hourly  Displays only hourly data for each of 24 hrs 

 30 Min  Displays every thirty minutes starting on the hour  

 15 Min  Displays only data logged every fifteen minutes starting on the hour 

 

Max Frequency:  the frequency indicates the percentage of time the wind blows from a particular direction.  

Max Frequency determines the maximum percentage of time which will be displayed on the wind rose.  

These frequency percentages appear as concentric circles emanating from the centre of the wind rose, the 

centre being zero and the frequency increasing to the outer circles.  If the wind is blowing at a greater 

frequency from any direction than the selected Max Frequency, then that wind spoke will extend past the 

boundaries of the wind rose.  This can be corrected by increasing the Max Frequency to extend the 

frequency range.    

 

 Example: Figure 4-44  
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Wind Speed Bins  

A Wind Speed Bin is a range of wind speed which will be colour-coded and superimposed on the wind rose for a 

visual analysis of the Wind Speed and Direction.  Once defined, each bin is automatically assigned a colour and 

will be displayed in the upper right hand corner of the Wind Rose (see Figure 4-44).      

 

 

 

 

 
Figure 4-44:  Wind Speed Bins Display 

 

For example: 

 The following ranges are input:             .   

 

 Selected units of measurement are kph 

 The Wind Speed Bins range from 1-2.9 kph (green), 3-5.9 kph (blue), 6-9.9 kph (maroon), 10-14.9 kph 

 (violet), 15-20.9 kph (yellow), and 21+ kph (cyan).   

 

 
Figure 4-45:  Wind Speed Bins Setup Example 
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4.10 DATA>VIEW AUDIT LOG MENU 

The Data>View Audit Log menu is another route to bring up the Audit Log Viewer previously explained in the  

Data>Collect Data and Telemetry Calls section.   

 

 
Figure 4-46:  Audit Log Viewer  

 

 
 

4.11 DATA>GET/SET DATA BY TAG NAME 

The Data>Get/Set Data by Tag Name menu will allow you to retrieve current variable values for selected data, 
and set values (when permitted) for selected user defined variables (such as setting cumulative rain amounts or . 
setting staff gauge/plate measurements).  This function will only set values in the Datalogger’s data file and will 
not affect data in the AutoCaller data base. 
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Figure 4-47: Get/Set Data by Tag Name Screen 

Choose Station:   Select the desired station by using  the drop down menu or use the search feature  The grey 

arrows can be used to go to the beginning/end of the station list or to scroll through by individual station..   

 

Group:  This lists the different groups in which the variables are found.  The lists can be expanded or minimized 

using the +/- icon. 

 

Variable Names:  Displays the variables found in each of the groups. 

 

Current Value:  Displays the current values for the named variables. 

 

New Value:   Used to set a new value.  This value will be saved to the Datalogger’s data file and used in any 

calculation or process that includes that variable.    

 

Selected:  Click on the checkbox to select the desired groups or specific variables from an expanded Group list.  

The top checkbox will select all values.  

 

Last Updated:  Will display the last time the value was updated. 

 

Call Method:  Use the drop down menu to select the desired call method. 

 

Call Status:  Indicates the status of the Call to the station 

 

Cancel Call:  Selecting this will cancel the call. 

 

4.11.1 Getting/Setting Values 

Prior to getting/setting a value, select the appropriate call method.  Click on the Refresh Tags button to ensure 

the most recent information is displayed.  Select the Get All Values or the Get Selected Values  button.   If the 

intention is to get selected values, ensure the selected checkbox for the desired Group or variable(s) has been 

made prior to getting the values. 
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CHAPTER 5 GRAPH MENU 

StreamTrac’s graphing capabilities allow easy production of graphs from your data.  Graphing data allows visual 
comparison of different data fields as well as comparing data from different stations.  Additionally, graph data 
can be edited visually with the graphing interface while the original data is preserved.  The graphing module 
contains many editing features. Some examples are: gap filling, data shifting and point by point 
dragging/editing. 

After initial display, the graph's appearance can be modified.  For example, the color and drawing style of a line 
can be changed or fields can be organized into separate graphs.  The Graphing Module provides several easy-to-
use editing tools that allow you to customize a valuable graph with the titles, labels, fonts, colors, and line styles 
you want.  A graph can be saved, allowing you to recall it at a later time. 

There are two types of graphs which can be produced:  a time series graph (in either line or bar form) and a wind 

rose (already seen in the Data>Dashboards section of this manual). 

5.1 VIEW EXISTING GRAPHS 

To view existing graphs select Graphs> Existing Graphs to display the Open Graph screen.  The graphs can be 

filtered based on Creator, Last Saved User, Last Saved Date and Graph Type.  The columns can be arranged by 

left clicking and dragging the column title to the desired position.  Left clicking on the column title will arrange 

the columns in alphabetical/reverse alphabetical or descending/ascending chronological order.   

Click on the desired graph to be opened and then select Open.  Graphs can be deleted the same way by 

selecting Delete.   

A new graph can be created by selecting the New button on the bottom of the page. 

 

 

Figure 5-1:  View Existing Graphs 
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5.2 CREATING A TIME SERIES GRAPH 

To create a time series graph, select Graphs>Open Blank Graphs>Time Series.  

 

 

Figure 5-2:  Creating a Time Series Graph 

Note:  the graph will appear blank until a station and a series to be plotted are selected.   

 

5.2.1 Adding or Modifying a Series 

Series are the lines or bars which populate the graph.  More than one series can be assigned to a particular 

graph.  The series can consist of data from different fields of the same station (including historical data) or data 

taken from several stations. 

To add a series click on the Series -> Add button.  

 

 
Figure 5-3:  Adding a Time Series Graph 

The Line Series Settings screen will be displayed.  Select the desired station and field from which to plot data, 

and then edit the other fields.  Continue to do this until all desired data from different stations and fields is 

entered. 
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Figure 5-4:  Adding a Graph Series 

Series Name:  The program will assign a default name consisting of the Station Name and the Selected Field.    

Select Colour: This will be automatically populated with an unused colour.  Use the drop down menu to make a 

different selection. 

Select Width:  Determines the width of the plotted line in pixels. 

Series Type:  The default series type is Line series but you can also create a Bar series.  However, data editing 

capabilities are not allowed when Bar series are chosen. 

 

Select Y Axis:  Select the axis on which to plot the series field.  The options are Right, Left and Both.  Always 

combine fields on the same axis that has similar upper and lower ranges 

View Times:  the drop down menu provides a series of options or a customized option can be typed in following 

the format of the drop down menu examples.  Times reflect the 24 hour clock.  The drop down menu 

consists of the following nine selections:   

 

 ALL  Graphs all data logged throughout the day 

 0..23  Graphs only hourly data for each of 24 hours 

 12:00  Graphs only noon data 

 13  Graphs only 13:00 (1 p.m.) data 

 1,3,5,7  Graphs only hours 1 a.m., 3 a.m., 5 a.m., and 7 a.m. data 

 7  Graphs only 7 a.m. 

 Hourly  Graphs only hourly data for each of 24 hrs 

 30 Min  Graphs every thirty minutes starting on the hour  

 15 Min  Graphs only data logged every fifteen minutes starting on the hour 

 

Show Points:  When checked, a small dot will appear at the data point in addition to the continuous line.  The 

point value and information will be displayed when the cursor hovers over it.  
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Figure 5-5:  Data Point Information 

Year to Year Series:  select the number of years of data to be included.  This will include historical data on the 

graph in individually assigned colours for every year. 

 

Once the settings are complete, click the OK button.  The series will appear in the graphing interface and the 

series name and colour will be shown in the legend. 

 

  

Figure 5-6:  Example Graph 

 

  

LEGEND 
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5.2.2 Graph tool bar  

These are the series of buttons which are found along the top and bottom border of the graph.  
 
Save/Delete/Print:  The graph can be saved, deleted or printed using the corresponding button.   
 

Series:  Use the drop down menu to add, modify or delete a series.  Hovering the cursor over Modify or Delete 
displays a list of the plotted series.  Click on the series you wish to amend.  

 

 
Figure 5-7:  Series Options 

View:  Use this drop down menu to select the information to be displayed on the graph and to adjust vertical 

scrolling and zooming options. 

 

Figure 5-8:  View Options 

Event Tags:  Figure 5-9 illustrates the symbols used on the graph to indicate event tags.  In order for 

the event tags to be displayed, the corresponding item in the View menu must be selected.  Hovering 

over these tags will bring up a dialog box which contains the information for that item. 

 

Figure 5-9:  Event Tags 

Visit Report 

Bottle Data (hover over this not the 
actual number to view the information) 

Note 
Storm Event 

Bottle Number 

Note dialog box  
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 Undo Zoom:  This will undo the last zoom. 

 View XY:  Selecting this will display the entire XY axis 

 View X:  Selecting this will display the entire X axis 

 Refresh:  The Refresh button retrieves the current values from the data.  If data changes are made to a 

series using the View/Edit Data tool you must click refresh to see the changes in the graphing module.   

Colours:  Use this to view and edit the graph line colours.  To change the colours, click on the feature you wish 

to change.  A colour chart will be displayed.  Select the desired colour and then OK.  Note that Normal and 

Raw cannot be edited. 

   

Figure 5-10:  Colour menus 

 General Graph Settings:  After a graph is produced the appearance can be customized using the 

advanced features using the menus found here.   

 

 

Figure 5-11:  General Graph Settings screen 
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Some of the editing choices available are:  

 

Change fonts, colors, and line styles  

Input the minimum and maximum axes values to be displayed 

Add labels and titles  

Turn zooming, panning etc. on and off.  

Export the finished graph as a BMP or WMF graphic file to be used in documents 

Print the graph 

The Chart Tab - Series sub-menu is not fully compatible with all StreamTrac functions.  Attempting to use this 
tab can cause StreamTrac to stop responding.  Relevant functions on this tab are done directly on the graph 
using the graph tool bars and buttons.  Changes made to the graph using this function will not be saved. 
 

        
Figure 5-12:  Chart Tab – Series sub tab 

 Data View:  The Data View button opens two dialogs: Point Information and View Series Data.  

Clicking on a data point will populate the Point Information dialog with information about that point and 

will populate the View Series Data dialog with the series data surrounding the point clicked (the clicked 

point will be highlighted). 

 

Figure 5-13:  Data View 

 Save Edits: Selecting this will save any edits made to the graph. 

 IMPORTANT 
 

DO NOT make any 
changes or adjustments 
to the graph using the 
Chart Tab – Series sub 

tab 
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Time Frame:  Use this to select the time frame of the graph to be displayed.  Click the Set Range 

button (clock icon) to open the date range edit interface.  From the set range dialog you can select 

either a date range or floating range.   

 

     
Figure 5-14:  Set Range: Date Range and Float Range options 

 To set a Date Range, select the date/time element you wish to change (it will be highlighted in blue) then 

use the up and down arrows to adjust it accordingly.   

 

The Float option allows you to select a "floating" date or time period based off the current time or last time 

run.  Use the drop down menu in the View field to display the choices.  Be sure to click the View All XY or 

View All X button after adjusting the date range to view the entire range.   
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5.2.3 Viewing Data 

Hovering the cursor over a series line or an event tag will bring up an information box for that item.   

 Scrolling 5.2.3.1

To scroll left, right, hold down the right mouse button and drag on the graph in any direction, or use the scroll 

bar to quickly move left or right. 

 

To scroll up and down, click on the View Icon and enable Allow Vertical Scrolling and use the scroll bar on the 

mouse to move up or down.    

 Start/End Cursors 5.2.3.2

To perform many of the manipulation functions you will be required to define a region on which to perform the 

functions.  This is accomplished using the Start and End Cursors. To position these cursors, right click on the 

graph and click either the Set Start Cursor or Set End cursor menu items. After cursors have been placed they 

can be moved by placing the mouse cursor over the line of the cursors and click-dragging left or right.  

 Zoom Functions 5.2.3.3

The zoom functions control zoom level on both axis.  Use the mouse to click and drag, from left to right and 

release the mouse button.  This creates a bounding box on the section of graph you to zoom in on.  However, it 

will only zoom horizontally along the X-axis unless vertical zooming is enabled.  To enable vertical zooming, click 

on the View Icon and enable Allow Vertical Zooming.  

 
To reverse zoom, use the mouse as above while holding the shift or the alt button.  The arrow button at the top 

of the screen    is an 'undo-zoom' button, which will return you to the previous view of your data. 

 
Y axis Zoom Functions: 
 

The zoom buttons on the left and right of the graphing screen control only the Y axis on that side.  

Zooming in and out with these will change the scale of the Y axis and adjust the plotted series 

accordingly.  The arrow button is an 'undo-zoom' button.  

 

To zoom vertically, click on the View Icon and enable Allow Vertical Scrolling.  
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5.2.4 Graph Interface Options 

 Start/End Cursors 5.2.4.1

Right clicking on a blank portion of the graph will display the Graph Interface menu.  It has four options:  Set 
Start Cursor, Set End Cursor, Add Note and Event Summary. 

 

 
Figure 5-15:  Graph Interface menu 

The Start/End Cursors are used to frame a section of data which can then be edited or manipulated using other 

graphing functions.   

Left click on Set Start Cursor and two hashed vertical lines will appear.  The green line indicates the data range 

start and the red line indicates the data range end.  Left click and drag the lines so that they mark the desired 

data range. 

 

Figure 5-16:  Start and End Cursors 

 Adding Notes 5.2.4.2

Notes can be added by right clicking on a blank section of the graph where you wish the note to appear and 

selecting the Add Note option.  The Modify Station Note screen will appear: 

 

Figure 5-17:  Add Note 

Start Cursor End Cursor 
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The Note Date and Time will reflect the cursor position.  This position can be adjusted by manually entering the 

date and time using the arrows.  Select the date and time of the note 

Show Full Note On Graph:  Check this to display the full note.  If left blank, the presence of a Note will be 

indicated by  and the full note will be displayed when the cursor is hovered over it.   

5.2.5 Setting Data Quality and Status 

Data can be labelled with its quality and status using the functions found on the Quality and Status tool bar 

located under the legend. 

The three quality settings are Good, Fair, and Poor.  The two status settings are Provisional and Approved.  To 

view/edit quality and status of a series, click the View QS button and select the desired series. 

 

 
Figure 5-18:  View QS menu of the Graph dialog 

Two bars will appear along the bottom of the graph; the top one is Quality, and the lower Status.  

After selecting a series, use the cursors to set a date/data range.  Right click anywhere on the graph to display 

the following menu: 

 

Left click on Set Start Cursor and two hashed vertical lines will appear:  one green (data range start) and one red 

(data range end).  Left click and drag the lines so that they mark the desired data range. Once a range has been 

set, click on the Set QS button  

 

 
Figure 5-19: Modify Data Quality and Status dialog 

A dialog will appear allowing you to select quality and status for your marked date-time range.  Note the Start/-

End cursor selections are indicated by the vertical red and green hashed lines and the selected range appears in 

the Date Range fields of the dialog box. 

 

After setting the quality and status, the two bars running along the bottom of the graph will be updated.  

NOTE: If the quality and status bars do not appear after clicking on View QS, click on 

Refresh. 
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 Adding Notes 5.2.5.1

Notes can be added by right clicking on a blank section of the graph where you wish the note to appear and 

selecting the Add Note option.  The Modify Station Note screen will appear: 

 

Figure 5-20:  Add Note 

The Note Date and Time will reflect the cursor position.  This position can be adjusted by manually entering the 

date and time using the arrows.  Select the date and time of the note 

Show Full Note On Graph:  Check this to display the full note.  If left blank, the presence of a Note will be 

indicated by  and the full note will be displayed when the cursor is hovered over it.   

5.2.6 Editing Series Data  

To begin editing data using the graph, right click either on the series or on the legend item for the series you 

wish to edit and the following menu will appear.   

 

 Figure 5-21:  Edit Data Graphical Interface  
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Add Storm Event:  The Add Storm Event feature allows addition of a storm event to the graph.  To add a storm 

event, use the Start/End cursors to set the range of the event and then right click on the series line or legend that 

you wish to mark as a Storm Event and then select Add Storm Event from the drop down menu.  

Copy Range: After marking a range of data (using the Start and End cursors) a range of a series graph can be 

copied into memory for pasting into the same station or into a different station using the Paste-Fit Range 

function.  

Paste-Fit Range:  The Paste-Fit function pastes a previously copied section of data into the area defined by the 

Start and End cursors.  If the target range is not identical to the copied range the data is proportionately 

fitted into the target range.  

Delete Range:  This will delete the range of data defined by the Start and End cursors.  A Note with the date and 

time of the action will automatically be inserted in the graph. 

Segment Interpolation:  This function will fill a missing section with data. It can do an interpolation between 

two points of existing data or fill a range of data with a constant value.  Figure 5-22 shows a graph which will 

be interpolated to fill a missing data range.  Use the start/end cursors to select the time-date range or enter 

the data points manually.  Start Y/End Y are the data points which frame the selected missing data.  Select 

Run.  A Note with the date and time of the action will automatically be inserted in the graph. 

 

Figure 5-22:  Graph Segment Interpolations 

Auto Interpolation:  This will fill multiple gaps linearly over a consistent sample interval.  .  Sample Interval is 

the minimum time gap before auto-interpolation takes effect.   Max Interpolation Gap refers to the 

maximum number of data points that are to be interpolated.  Auto Interpolation will fill the gap to either the 

maximum number of interpolation points or to the end range date and time, whichever is reached first.  A 

Note with the date and time of the action will automatically be inserted in the graph. 

For example:  Figure 5- 23 shows that a data point will be plotted every 10 minutes for a maximum of 30 

data points.  Auto interpolation will stop at 2006-01-10 at 16:17, after 300 minutes (10 minute interval x 30 

data points), well before the end range date and time. In order to auto interpolate the entire range, ensure 

the Sample Interval and Max Interpolation Gap settings permit that.   



StreamTrac  

700-ST-MAN  Rev. 2 -  29 Oct 2015  Page 109/155 

 

Figure 5-23: Graph Auto Interpolation 

Constant Bias Shift:  This option lets you shift all of the data in a selected time period and shift it up or down by 

a constant amount, or assign a constant value to a range of points.  The time range will default to the range 

between cursors if they are set up, otherwise the default is the current day and time.  A Note with the date 

and time of the action will automatically be inserted in the graph. 

 

The following example shows that a constant shift bias of 10 degrees was applied to the range of data (Demo-

Avg Temp) framed between the cursors.  Once Run was selected, the data points between the cursors moved 10 

degrees higher than the previous values. 

 

 

Figure 5-24: Constant Shift Bias  

Variable Shift (Drift Correction):  This function allows the editing of a series by moving a sub-set of data along 

one or more pivot points.  This function is useful in correcting sensor drifts due to fouling.  A Note with the 

date and time of the action will automatically be inserted in the graph. 
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Figure 5-25:  Variable Shift (Drift Correction) 

 

Select Add pivot point and click the graph where this pivot point is to be placed.  Shifting this pivot point by 

dragging it will shift the data points within the selected range.  A Proportional shift will move the pivot point and 

the other points while maintaining a proportional distance between the points.  A Constant shift will maintain 

the relationship between the pivot point and the data points and shift the data points using the same bias by 

which the pivot point is shifted.  See Figure 5-26. 

 

            
 Adding Pivot Point Proportional Variable Shift  Constant Variable Shift 

Figure 5-26: Single Pivot Point Shifts 

Adding a second pivot point will cause the data point to shift between the two pivot points within the selected 

range when the left hand pivot point is moved.  If the right hand pivot point is moved, all the data within the 

range will shift for a Proportional shift 
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Shifting Left Pivot Point Shifting Right Pivot Point       Shifting Left Pivot Point     Shifting Right Pivot  

 

 Proportional Variable Shift   Constant Variable Shift 

 

Figure 5-27:  Duo Pivot Point Shifts 

Reconstruct:  This function aids in the reconstruction of a series by using the relationship of this series to 

another field (surrogate) over a period of time when both fields were present.  A Note with the date and 

time of the action will automatically be inserted in the graph. 

 

Figure 5-28:  Reconstruct Data Dialog 

Graphical Point Editing:  The point editing method allows a user to physically drag the data points up or down 

to correct data errors.  Simply click and drag each point with the mouse to the required new value.  This 

method also allows double-clicking above or below a point, which will move the point up or down to the 

double-clicked spot.  This is helpful for removing data outliers. 
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Figure 5-29:  Edit Series Data Dialog 

Mathematical Editing:  This function will fill a range of data using a mathematical formula.  See the 

Stations>Stations Setup>Calculations section of this manual for details of completing the form.  The 

Formula can use another field within the current record set to calculate values. 

 
Figure 5-30: Calculation Form 

Restore Original Data:  This function discards all changes to the data (even if changes have been saved).  

Clicking on this menu item will restore the data to its original form (the Raw data for each field or series).  

Raw data is stored separately from edited data; therefore, it is always available for restoring data to its 

original state.  
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5.3 STORM EVENTS  

A storm is identified by a rise and fall in turbidity.  StreamTrac allows you to create what is called a Storm Event 
to track these occurrences.  The event allows you to calculate the estimated load of sediment for the period of 
the storm.  
 
To create a storm event, use the cursors to mark the beginning and end of the event then right click on the line 
series or on the legend label and select Add Storm Event from the popup menu. 

 

 
Figure 5-31:  Add an event 

To open an existing event: right click on the event tag in the graph interface then select View/Modify.  
 
Opening an event will present the Regression and Calculation which is used to calculate the trend of 
suspended sediment against turbidity over the period of the event (Event Load Calculation).  
 
To delete an event: right click on the event tag in the graph interface then select Delete. 
 

5.3.1 Event Load Calculations 

The Regression and Calculation screen is used to calculate the trend of suspended sediment against turbidity 

over the period of the storm event. There are a number of ways to display the data and execute the calculations.  
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Figure 5-32:  Regression and Calculation screen 

The Station and Event number will be auto populate.  The Start and End time will be the range delineated by 
the Start/End cursors.  This can be fine-tuned by manually adjusting the date and time using the arrows. 
 
Description:  This will be auto populated sequentially.  An event name can be manually entered if desired.  

The graph’s look can be customized using the General Graph Settings Tool.  

 Method Tab 5.3.1.1

Y axis:  The Y axis will be SSC (suspended sediment concentrations). 

X Axis:  Use the drop down menu to select either Discharge or Turbidity.  
 
Regression Model:  This drop-down selector allows you to choose the regression model you like to 

use.  The options are: 

  Least Squares 
  LOWESS 

Log-Log 
Power Function 

Use the checkboxes to view/display the associated data. 

 Notes/Attachments Tab 5.3.1.2

This tab is used to add notes and add attachments. 
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Figure 5-33:  Notes/Attachments Tab 

 Advanced Settings Tab 5.3.1.3

This tab is used to customize the Curve Settings.  Use the drop down menus to select the variables available for 
selection on the Method Tab.   
 
 
 

 
Figure 5-34:  Advanced Settings Tab 

5.3.2 Trend line Relationship Calculations 

 Linear 5.3.2.1

Calculates the least squares fit (minimal sum of the deviations squared) for a line represented by the 

following equation: 

       

where   is the slope and   is the intercept. 

A linear trend line is a best-fit straight line that is used with simple linear data sets. Your data is linear if 

the pattern in its data points resembles a line. A linear relationship usually shows that a variable is 

increasing or decreasing at a steady rate. 

Coefficients   and   can therefore be obtained:  
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where  ∑  stands for ∑   
   . 

 

 Polynomial 5.3.2.2

Calculates the least squares fit through points by using the following equation: 

                 
      

         
  

where   and           are constants. 

A polynomial trend line is a curved line that is used when data fluctuates. It is useful, for example, for 

analyzing gains and losses over a large data set. The order of the polynomial can be determined by the 

number of fluctuations in the data or by how many bends (hills and valleys) appear in the curve. An 

order 2 polynomial trend line has at most one hill or valley, order 3 at most two hills or valleys, order 4 

generally has up to three. 

As an example a 2nd-order polynomial trend line (one hill) could illustrate the relationship between 

speed and gasoline consumption.  

 Logarithmic 5.3.2.3

Calculates the least squares fit through points by using the following equation: 

              

where   and   are constants. 

A logarithmic trend line is a best-fit curved line that is most useful when the rate of change in the data 

increases or decreases quickly and then levels out. A logarithmic trend line can use negative and/or 

positive values. 

 Exponential 5.3.2.4

Calculates the least squares fit through points by using the following equation: 

         

where   and   are constants. 

An exponential trend line is a curved line that is most useful when data values rise or fall at 

increasingly higher rates. You cannot create an exponential trend line if your data contains zero or 

negative values. 
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 Power 5.3.2.5

Calculates the least squares fit through points by using the following equation: 

        

where   and   are constants. 

A power trend line is a curved line that is best used with data sets that compare measurements that 

increase at a specific rate.  For example, the acceleration of a race car at 1-second intervals.  You 

cannot create a power trend line if your data contains zero or negative values. 

 R-squared Value 5.3.2.6

Note: The R-squared value you can display with a trend line is not an adjusted R-squared value. For 

logarithmic, power, and exponential trend lines, Microsoft Excel uses a transformed regression model. 

  and   are defined in this model as:  
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(Kenney and Keeping 1962). These can be rewritten in a simpler form by defining the sums of squares:  
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Which are also written as: 
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Here,    (   ) is the covariance and   
  and   

  are the variances. 

Note that the quantities ∑     
 
    and ∑   

  
    can also be interpreted as the dot products 

http://mathworld.wolfram.com/Covariance.html
http://mathworld.wolfram.com/DotProduct.html
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In terms of the sums of squares, the regression coefficient   is given by  

   
   (   )

  
  

ss  

ss  
  

and   is given in terms of   as 

   ̅    ̅ 

The overall quality of the fit is then parameterized in terms of a quantity known as the correlation 

coefficient, defined by 

    
ss  
 

ss   ss  
 

which gives the proportion of  ss   which is accounted for by the regression. 

Let  ̂   be the vertical coordinate of the best- fit line with x- coordinate   , that is,  

 ̂           

then the error between the actual vertical point    and the fitted point is given by:  

        ̂  

Now define   as an estimator for the variance in     Then   can be given by: 

  √
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(Acton 1966, pp. 32-35; Gonick and Smith 1993, pp. 202-204).  

The standard errors for   and   are: 
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http://mathworld.wolfram.com/CorrelationCoefficient.html
http://mathworld.wolfram.com/CorrelationCoefficient.html
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 Standard Error 5.3.2.7

There are two different definitions of the standard error.  

The standard error of a sample of sample size n is the sample's standard deviation divided by√ .  It 

therefore estimates the standard deviation of the sample mean based on the population mean (Press 

et al. 1992, p. 465).  Note that while this definition makes no reference to a normal distribution, many 

uses of this quantity implicitly assume such a distribution.  

The standard error of an estimate may also be defined as the square root of the estimated error 

variance  ̂  of the quantity: 

    √ ̂
  

(Kenney and Keeping, p. 187; Zwillinger 1995, p. 626).  

 
  

http://mathworld.wolfram.com/StandardDeviation.html
http://mathworld.wolfram.com/StandardDeviation.html
http://mathworld.wolfram.com/Variance.html
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5.4 CREATING A WIND ROSE GRAPH 

To create a wind rose graph, select Graphs>Open Blank Graphs>Windrose.  The main graphing screen will 

appear.   

 Note:  The graph will appear blank until the station, a wind speed parameter and wind direction parameter 

fields are populated.   

 

Figure 5-35:  Creating a Wind Rose Graph 

Station:  Use the drop down menu to select a station. 

Time Range (Clock):  See #1 in Figure 5-36.  Set the desired time range to be graphed (either a range or a float 

time).  The Float option allows you to select a "floating" date or time period based off the current time or last 

time run.  For example, you can select "Since Beginning of Year" which could be one day to 365 days’ worth of 

data.  To update the data points in the date range, click on the Update Data button. 

Wind Speed Field:  Use the drop down menu to select the wind speed field. 

Wind Direction Field:  Use the drop down menu to select the wind direction field. 

Wind Speed Bins:  Input the speed start range for each of the bins.  The bins will be displayed in the legend (#2 

in Figure 5-36) along with the percentage of wind in each bin over the input time range.  

Number of Directions:  Select the number of radial arms the wind rose will display.  

Times in View:  Use the drop down menu to select a time or input your own. 

Max Frequency:  Input the maximum percentage that will be displayed in the radiating concentric circles. 

Once all fields are populated, select Save Layout. 
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Figure 5-36:  Windrose Graph 

Save Layout:  This button saves the graph in its current state so it can be viewed at a later date.  The 

graph name will be automatically populated with the station name but this can be changed if 

desired.  

Delete:  This button will delete the current graph. 

Export Data:  This will open a browse window to export the graph as a bit map (.bmp) file to the 

selected folder.   

5.4.1 Editing Graph Data 

Any of the parameters can be amended by clicking on the field and changing as required.  Update the 
graph by selecting the Refresh button to display any changes. 
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CHAPTER 6 SITE VISITS 

6.1 SITE VISIT FORMS 

The purpose of these forms is to record various information and conditions during a visit to the site. 

One of the most important pieces of information for Suspended Sediment calculation is the bottle 

position recording within the auto sampler.  

The StreamTrac software requires that the bottle number contained in each carousel slot be recorded 

at the time that the bottles are swapped (full bottles removed and empty ones put in their place).  In 

other words, record when you leave the site, NOT when you arrive. Secondly, the date time of the 

bottle swapping as well as station name must be accurately recorded on this electronic form. 

Once the bottle numbers are recorded, the StreamTrac software will seamlessly place the bottle 

numbers in the proper place within the data stream requiring. 

6.2 NEW SITE VISIT 

To issue a new Site Visit form, from the main menu click on Site Visits> Issue New Site Visit.  Use the 

drop down menu which appears in the Issue New Site Visit dialog box to input the Station’s name.  

 

Figure 6-1:  Issue New Site Visit dialog box 

The Site Visit form will be displayed.   

6.2.1 Carousel-Bottle Mapping Tab 

From this screen you can record bottle numbers and their corresponding carousel slot numbers, as 

well as record the SSC results once the samples have been processed.  

The Start Date & Time is the only mandatory field.  All other fields can remain blank if desired. 
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Figure 6-2:  New Site Visit Form 
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CHAPTER 7     SETTINGS MENU 

When first installed on the Calling Service Computer or the Remote User Computer, the StreamTrac system 

interacts with the locally installed StreamTrac Database (FTSdata.mdb). The Switch to Another Database menu 

option allows a user running the StreamTrac Application on a Remote User Computer to switch from the 

locally installed database to the main database used by the Calling Service.  This enables the remote user to 

monitor calls and view data from the main StreamTrac Database.  The remote user must have network 

privileges to allow them to connect to the computer which contains the main database. 

To switch to another database, select the Choose button to browse to the desired path. 

When switching to a Microsoft SQL Server your network administrator or DBO must first transfer your database 

from MS Access to the SQL server before switching.  The database on the server must allow full security rights to 

all StreamTrac users.  This includes table add and delete rights.  Your network administrator will need to fill in the 

SQL section shown. 

 

 
Figure 7-1:  Settings Menu 

Important - Note: 

The DATA> SWITCH DATABASE menu is intended to be used to select between a local database 

and the main StreamTrac Database when running the StreamTrac Application on a Remote 

User Computer.   

If the user connects the StreamTrac Application to a different database and the StreamTrac 

Application is running on the same computer as the Calling Service then the Calling Service 

will also use the newly selected database.   
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7.1 SETTINGS>USER ACCOUNTS 

Selecting Settings>User Accounts will display, in tabular form, a list of all Administrators and User accounts.  

From this page, users can be added, deleted, and their accounts edited.  However, only those with Administrator 

rights are able to perform those functions. 

 

 
Figure 7-2:  User Accounts Display 

7.1.1 Adding/Editing Users 

When adding or editing a user the User Account screen is displayed.  It contains access right controls for the 

various components of StreamTrac.  It should be noted that some settings will affect other components or 

settings.  For example: The Data Access - Edit option controls the ability to edit data in the View/Edit screen as 

well as the graphing screen. See the descriptions below for more information. 
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Figure 7-3:  Assigning User Access Rights 

7.1.2 Access Rights Descriptions 

ADMINISTRATION 
 
User Accounts: Allows overall administrator rights  

Station Master: allows adding deleting and all other changes to the station.  

Group Set-up: Allows the user to create and modify station groups. 

Switch/Set Database: User can change the connection to the default or active database.  

Global Settings: Gives access to the screen where global date formats and other common settings are stored. 

Audit Log:   

 
DATA ACCESS 
 
View: User allowed only to view data both in tabular and graphing views. 

Edit: Users are allowed to edit data both in the tabular form and on the graphing form. Data edits include 

Sensor/Field record data, Graph Notes, Events, Site visits and data corrections.  

Collect: Allows access to the data collection menu items. However, if not ticked users can still make calls that 

provide information only such as Current conditions and Data Logger information but will not allow calls 

which add to the sensor variable database such as collect data by date range and collect data since last call 

etc.  
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Import: Controls access to the ability of users to import data from text or CSV files into the station database.  

Export: Controls the exporting of data to text or CSV files.  

Transfer-In: Controls Access to the data transfer method of moving data from a data transfer zip file into the 

database (similar to importing).  

Transfer-Out: Controls Access to the data transfer method of moving data from the database to a data transfer 

zip file (similar to exporting).  

Alarms:  Users are allowed to set alarms. 

GRAPHS 
 
Create:  Allows access to creating blank graphs.  

Edit:  Allows users to edit graph layouts, i.e. the number of series on the forms, the colours of the series and 

Adding Events and notes etc…not to be confused with editing actual data using the graph’s editing tools. 

For access to editing data using the graph Data Access-Edit feature item must be selected.  

View:  Allows user to view existing graphs only.  

Delete:  Allows deletion of graphs 

 

SITE VISITS 
 
Create: Allows users to create a new site visit.  

Modify: Allows an existing site visit to be added.  

Delete: Allows a user to delete a site visit form. 
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7.2 Settings>Language 

StreamTrac’s interface can be set up in any of three languages: English, Spanish, and Chinese.  The 

Settings>Language menu displays the Change Language screen.  Use the drop down menu to select the 

language of choice.    

 

 

 

Figure 7-4: Change Language menu 

 

NOTE: The regional language pack must be installed for the proper characters to 

appear, especially in the case of the completely graphical Chinese characters 

(Unicode).  

 

7.3 SETTINGS>GLOBAL SETTINGS MENU 

The Global settings menu allows the user to make changes to the file storage path, date and time display 

formats, and the outgoing alarm settings. 

 

 
Figure 7-5:  Global Settings Menu 
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7.3.1 Overall Systems Settings 

File Storage Path:   This path is the location where StreamTrac can store and create its sub-directory structure.  

It is recommended that this be the running folder of the StreamTrac software, which is also the location of 

the StreamTrac database, thereby keeping everything in one folder which makes back-ups as easy as 

copying the contents of this folder onto your backup location.  Use this to browse to the directory and select 

the desired file path for the StreamTrac Database. 

Date Display Format:  Use this drop down menu to select the desired date display format which will be used 

throughout the StreamTrac program. 

Time Display Format:  Use this drop down menu to select the desired time date display format which will be 

used throughout the StreamTrac program.   

Hydro Year Prefix:  This is the identifying prefix for the Hydro Year.  The default setting is HY and this can be 

changed if desired. 

Date From/To:  This defines the start and end date of the hydro year.  When a start date is inserted in the Date 

From field, the To field is automatically populated to end one year after the From date. 

7.3.2 Outgoing Alarm Mail Settings 

These settings affect the Data Alarm Service. These settings should be verified with your local network 

administrator. 

Host/Server:   This is the name or IP address of your SMTP mail server through which alarms will be directed. 

Port:  This is the port the server will accessed on (default port for SMTP is 25). 

Use Authentication:   Select this to set a password to allow the SMTP server to accept and forward e-mails.  

When selected, input User and Password details.  The Use SSL/TLS option attempts to send the username and 

password over a secure channel.  This must be setup on the mail server. Some mail servers require this to 

connect. 

From Address (optional):  This optional field can be filled in to identify the e-mail or text message of the alarm’s 

originating sender.   

Max Notify Frequency:   Input the desired frequency to be notified of any alarms.  Specifically, if an alarm is 

triggered once, and then subsequently triggered, another notification will not take place unless the alarm is 

triggered AFTER the maximum notification frequency time. 

 
  



StreamTrac  

700-ST-MAN  Rev. 2 -  29 Oct 2015  Page 130/155 

7.4 SETTINGS>COMPACT DATABASE MENU 

If the StreamTrac Database is connected to a Microsoft Access database (.MDB), it may occasionally need to be 

compacted.  Clicking this option immediately presents you with a confirmation warning and then will begin this 

process once Yes is selected.   

 

 
Figure 7-6: Confirm Compact Database 

 

IMPORTANT NOTE:  Ensure the AutoCaller service, data alarm service and the FTS 

Importer/Exporter service are stopped and that no remote users are actively 

connected to the database prior to performing this operation. 
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CHAPTER 8 HELP MENU 

8.1 HELP FILES 

This menu item allows users to access a PDF version of this the User Manual and other reference documents.  If 

more assistance is necessary, contact the FTS Technical Support (contact information located on the frontispiece 

of this manual). 

 

8.2 ABOUT 

The About menu allows the users to view the particulars of the StreamTrac system.  Software version is displayed 

as well as the License Count for the number of stations that can automatically be called by the StreamTrac 

Calling Service. 

 
Figure 8-1:  About Screen 

Add AutoCaller Service Licenses:  The Add AutoCaller Service Licenses button opens the dialog box shown 

in Figure 8-2.  The dialog box prompts the user to enter the 16 character License Code provided by FTS 

which then enables the StreamTrac Service to automatically call the licensed number of stations. 

 
Figure 8-2: Update Software Licenses screen 

Upon correctly entering the License Code, the Software Name, Software Number, and License will automatically 

be displayed.  After clicking the Update button, the AutoCaller calling service must be restarted (see the 

Stopping & Starting the Calling Service section in this manual) in order for the License information to take effect. 
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CHAPTER 9 TELEMETRY 

9.1 COMMUNICATION TYPE - FTS 

The FTS Telemetry type encompasses direct data logger connections as well as telephone, radio, satellite, or IP 

modem connections used to retrieve data from a remote monitoring station.  Parameters of the remote site’s 

data logger and telemetry equipment as well as parameters for the computer calling the remote station must be 

properly identified in the communication method’s FTS Telemetry window (shown below) in order to 

communicate with the remote station.   

Access to this window is provided through STATIONS> Station Setup > Add/Modify/Delete Communication 

Method button. 

 

Figure 9-1:  FTS Telemetry Example 

Note: Figure 9-1 is an example of an FTS Telemetry communication method for a remote 

station FTS Demo.  On this computer (CEDAR), modems on either Com1 or Com2 can be 

used to connect to the radio cluster hub site which has a TM Ultra telephone modem and 

an RMX radio modem (ID: 010Ah).  The hub site communicates with repeater site (ID: 

C02Fh) which communicates with the FWS-12S Data logger at the FTS Demo site via FTS 

Demo’s RMX radio modem (ID: 0005h). 

 

 



StreamTrac  

700-ST-MAN  Rev. 2 -  29 Oct 2015  Page 133/155 

 

9.1.1 Description 

The Description field displays the name of this particular Communication Method at the time it was created.  The 

name given in the Description field will appear in the Communication Tab – Site Specific Communication 

Methods list and also in the Communication Methods choices list when making manual calls to the station.  

When naming a communication method, a good practice is to begin the name of the communication method 

with the name of the computer on which the communication method can be used.  This allows remote users to 

easily identify the communication method they defined for use with their computer and modem (i.e. see Figure 

9-1: “CEDAR- FTS Telemetry Example”). 

 Datalogger Information  9.1.1.1

Data Logger Type: this field identifies the model of FTS data logger at the remote site.  Select the appropriate 

model from the drop-down menu list.  If the remote site does not have a data logger (i.e. is a radio repeater 

site only) then select ‘None’. 

Password Box:  If your data logger is password enabled (i.e. a password has been set in the logger) then in order 

to perform certain functions such as Set Time, Send Data Logger Program and other functions which may 

change the behavior of the logger you will need to enter this password in this box.  

Use Saved Sensor Sets:   Sensor set information is information about the data that the data logger transmits 

along with the actual data on each data request (i.e., data field names, data storage information, etc.).   

If the Use Saved Sensor Sets checkbox is enabled then on the first data call to the station the returned data 

logger sensor set information will be saved.  Subsequent calls to the station will result in only data being 

collected from the data logger.  If the saved sensor set information does not match the incoming data, 

StreamTrac will automatically update its sensor set information.  The user should enable the Use Saved 

Sensor Sets option when utilizing telemetry options that incur airtime charges as this option will minimize 

the data transmitted from the station on each data call. 

 Telemetry Options 9.1.1.2

There are three Telemetry options: Direct Connection, Phone Modem, and Radio Modem.  When one is selected, 

the associated fields will be unlocked and able to be input with the necessary information.   

 
Figure 9-2:  Telemetry Options 

All three options require the Allowed Com Ports, Baud Rate and Wakeup Delay fields to be populated.   

Choose Allowed COM Ports  
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The Choose Allowed COM Ports selection box is used to select which of the computer’s COM ports can be used 

to contact the station.  The StreamTrac system is multi-call, multi-thread capable so all of the COM ports on the 

computer which can be used to connect to the remote station can be identified.  When making a call to a remote 

site, the Calling Service will use whichever of the allowable COM ports (and associated modem) is available to 

place the call. 

Important - Note: 

COM ports are hardware devices which are specific to each computer.  A user on a Remote User computer 

cannot initiate a call to a station with a communication method that was configured for use on the 

Calling Service computer.  This is because the Remote User computer is not able to access and control the 

COM ports on the Calling Service computer.  

If the user wishes to place a manual call to the station with the Application running on a Remote User 

computer then the user must configure a communication method which utilizes a COM port (and 

associated modem) on the Remote User computer.  This is why it is good practice to begin the name of the 

communication method with the name of the computer on which the communication method can be 

used. 

 

Baud Rate  

The baud rate required for the chosen telemetry configuration is usually automatically set by StreamTrac; 

however, the Baud Rate drop-down menu may be used to override the default selection 

Default baud rates for the various FTS telemetry devices are shown in the table below. 

Telemetry Device Baud Rate 

  
     Direct Connection 9600 baud 

     TM4000 telephone modem 1200 baud 

     TM Ultra telephone modem 9600 baud 

     RM 4000 radio modem 1200 baud 

     RMX radio modem 4800 or 9600 baud (1) 

     Globalstar satellite modem 9600 baud 

     MSAT satellite modem 9600 baud 

     IP Modem not used 

(1) Setting is dependent on the RMX radio modem configuration 

Wakeup Delay  

This is the time interval allowed for the station to respond to a query originating from StreamTrac.  This ensures 

two-way communication is established  prior to transmitting any information or data.  If the station does not 

respond within this time interval, StreamTrac will continue to attempt to “wakeup” the station.  The default 

setting is 300ms but it can be manually changed to meet specific requirements (ie: older equipment may require 

a longer interval);  

   

Each individual FTS communication method can only have one of the following telemetry 

configurations defined: 

• Direct Computer to Data logger Connection 
• Direct Computer to Radio Modem Connection 
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• Telephone Modem to Data logger Connection 
• IP Modem to Data logger Connection 
• Combination Telephone / Radio Modem to the Data logger 

 
The setting of the options below determines the telemetry configuration.  As the telemetry is 

configured, the telemetry path for the remote site is visually displayed at the bottom of the FTS 

Telemetry window (see Telemetry Path section).   

Double-clicking on a telemetry icon will enable or disable that particular telemetry device from the telemetry. 

Direct Computer to Datalogger Connection  

This option is used when a point-to-point cable connection exists between the station’s data logger and the 

computer’s COM port.  Select the Direct Connection check box.   

 

 

The telemetry path will display the Direct icon with the 

Data Logger Type. 

 

 
Figure 9-3:  Telemetry Path Example 

 

Telephone Modem to Datalogger Connection 

The Phone Modem selection box should be selected when either: 

a) the remote station is equipped with a telephone modem, or 

b) the radio cluster hub site of the radio path to the remote site is equipped with a 

telephone modem.   

Select the Phone Modem checkbox.  Use the Modem Type drop down menu to select the modem type and 

enter the phone number for the remote site.   

 

Telephone Numbers:  Valid telephone number characters are numbers (0-9), brackets (for readability ie: area 

codes), and commas (dial pause operator for getting outside line). Do not use dashes or spaces. 

  Telephone number example:   9,1(555)1239875 

 

 

The Telemetry Path will display the modem type with 

Data Logger Type. 

 

 
Figure 9-4: Telemetry Path Example  
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IP Modem to Datalogger Connection 

The IP Modem option is selected when the remote site is equipped with a modem which 

communicates over the internet (i.e. a digital cellular modem).  This modem type does not require a 

computer COM port as the communications to the remote site are via the internet.    

 
Figure 9-5: IP Modem to Datalogger Connections Screen 

DNS:  The DNS (domain name server) field is the name used by the domain name server to identify the remote 

site’s IP Modem.  .  A DNS entry is required when the remote modem does not have a static IP address.  However, 

the DNS field is not required when the remote modem is provisioned with a static IP address.   If information is 

entered into both fields, then the information in the DNS field takes precedence. 

IP Address:  The IP Address field is the static IP address of the remote site’s IP modem.  The IP Address field 

should be left blank if the DNS field is used to identify the remote modem. 

Port Number:  The Port Number field identifies the device port used by the remote site’s IP modem. 

The telemetry path will display the IPModem icon with 

the Data Logger Type. 

 

 
Figure 9-6:  Telemetry Path Example 

 

Radio Modem to Datalogger Connection 

The Radio Modem checkbox should be selected when a radio modem (either an RM4000, TS4000, or an RMX) is 

used to communicate to the remote site.  After selecting the Radio Modem selection box, the radio modem 

buttons below the Telemetry Path box are enabled.  Use the Add RM button to select the type of modem, and 

then enter its hexadecimal address 

 

         
Figure 9-7:  Adding a Radio Modem to Datalogger Connection 

Several Radio Modems may be entered by following the above steps if there is a radio cluster hub which is being 

used to communicate with the datalogger.   
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Combination Telephone/Radio Modem to Datalogger Connection 

To setup up a telephone/radio to datalogger connection, select both the Phone Modem and Radio Modem 

checkboxes, then add the appropriate modems following the preceding steps.   

The telemetry path will display the selected 

telephone and radio modems with the datalogger. 

 
Figure 9-8:  Telemetry path Example 

 Telemetry Path 9.1.1.3

The communication path from the office computer to the remote site is pictorially displayed in the Telemetry 

Path box.  The radio modem buttons below the Telemetry Path box are used to manage radio modem path 

information for remote sites which use radio communications.  As radio modems are added and deleted the 

appropriate icons are shown in the telemetry path.  Double-clicking a telemetry icon will disable/enable the 

telemetry device from the station’s telemetry path without deleting information entered in the Admin 

Application. 

 

 
Figure 9-9:  Telemetry Path iconically displayed 

Add RM (Radio Modem):  This control is used to insert a radio modem into the telemetry path for the remote 

site.  When adding a radio modem 4 digit hexadecimal address for each radio modem in the path must be 

supplied.  When adding an RM4000, the hexadecimal address is determined by the RM4000’s serial number.  

When adding an RMX, the hexadecimal address is determined by the RMX’s programmable Station ID 

setting.  

 

IMPORTANT:   The RM4000 and RMX radio modems are not compatible with each 

other so they cannot be selected to be in the same telemetry path 

 

Remove RM (Radio Modem:   This control is used to delete the selected radio modem from the remote station’s 

telemetry path.  To select a radio modem, single click on the modem (the modem’s address will become 

highlighted with a blue background).   
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Edit RM Address:  This control is used edit the hexadecimal address of the selected radio modem.  To select a 

radio modem, single click on the modem (the modem’s address will become highlighted with a blue 

background). 

Enable Telemetry Devices:  This control is used to enable all telemetry devices in the station’s telemetry path 

that were disabled. 

 

 Configuring Comm Ports 9.1.1.4

Clicking the Global Computer Port Setup button opens the Serial Port Setup Screen which is used to define 

which COM ports are available on the computer and also to define the specifics for each COM port’s modem 

(computer modem, data logger, radio modem, etc.). 

 

 
Figure 9-10:  Global Computer Port Setup button 

The Serial Port Setup menu only applies to the computer that is running StreamTrac.  That is, if StreamTrac is 

running on Remote User Computer #1 it cannot configure the COM ports on any other Remote User Computer 

or the Calling Service Computer even if Remote User Computer #1 is connected to another computer’s database.  

If you wish to perform a manual call using StreamTrac on a Remote User computer, you must configure the 

Remote User computer’s COM ports and then define a communication method which uses the appropriate port.  

Computer Port Setup information is not stored in the StreamTrac Database - port information is stored locally 

on each computer. 

 

Important  Note:  The StreamTrac Application does not use Windows modem driver 

information.  Modem configuration information must be supplied in the Serial Port 

Setup window.  

Refer to the STATIONS> Station Setup> Communication Type – FTS> Serial Port Setup section of the manual 

for details on configuring the computer’s COM ports. 
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Serial Port Setup Screen 

 
Figure 9-11:  Serial Port Setup screen 

Com #: The Com# field refers to the actual computer’s serial COM port.  Green numbers indicate that the Com 

port is active.  Ref numbers indicate an inactive com port.  This field is not editable. 

Active: The Active field is a checkbox which, when selected, signals to the StreamTrac system that the 

corresponding COM port is available for use.  The port’s Com# field changes from red to green when the 

Active checkbox is selected. 

Modem: The Modem field is a drop-down list which allows the user to select which model modem is connected 

to the COM port.  To display the drop down menu, click on the empty Modem field for the relevant Com# 

line.  When a particular modem is selected the TM4000 and TM Ultra Initialization fields are automatically 

configured for the selected modem. 

Description: The Description field is a textbox which allows a user to enter a descriptive name for the port.  The 

name provided by the user appears in the Choose Allowed Ports window when configuring FTS Telemetry 

methods. 

TM4000 Init:  The TM4000 Init field is a textbox which contains the initialization string required for the 

computer’s modem to communicate effectively with a remote site’s FTS TM4000 telephone modem.  This 

field is automatically configured when the user selects a modem from the drop-down menu in the Modem 

field; however, the initialization strings in this field can be user modified as required.  For proper 

communications with a TM4000, the computer modem should be initialized as follows: 

1) its baud rate fixed at 1200 bps; 

2) data compression should be disabled; and 

3) error correction should be disabled. 

TM Ultra Init: The TM Ultra Init field is a textbox which contains the initialization string required for the 

computer’s modem to communicate effectively with a remote site’s FTS TM Ultra telephone modem.  This 

field is automatically configured when the user selects a modem from the drop-down menu in the Modem 

field; however, the initialization strings in this field can be user modified as required.  Normally the default 

settings are appropriate for the TM Ultra as the TM Ultra is a relatively modern telephone modem.   

Dial Prefix:  The Dial Prefix field allows a user to enter a prefix to each call made using this COM port.  The 

intention of this field is for the user to enter the specific prefix required to gain access to an outside 
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telephone line instead of adding the prefix to each station’s telephone number.  For example – a prefix of ‘9,’ 

(dial 9 and then a comma): 9 to get an outside line and a comma to add a delay while the outside line is 

being switched in. 

IMPORTANT!. Ensure that you do not add the dial prefix both here and in the FTS Telemetry 

page Telephone Number field.  The dial prefix is only required in one location.  

Dial Command (Dial CMD):  The Dial CMD field allows a user to enter a command that will be used to dial the 

modem attached to this COM port.  If this field is left blank, the Dial Command for the modem defaults to 

Hayes AT command set standard of ATDT (Attention and Dial Tone).   

Hang-up Method:  The Hang-up Method field allows the user to select which method is used to disconnect 

from a device connected to the COM port.  The two options are drop the DTR (Data Terminal Ready) line 

(standard for most telephone modems) or use the command string defined in the Hang-up String field. 

Hang-up String:  The Hang-up String field allows a user to enter a specific string that will be used to disconnect 

from a device connected to the COM port.  Refer to your modem manual for this information.  Note that the 

following hang-up string is required when using MSAT satellite modems:  +++~~~ATH0^M. 
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9.2 COMMUNICATION TYPE – GOES TELEMETRY 

An Internet connection to NOAA’s LRGS database is used to retrieve station data sent over the GOES satellite 

network.  In order to establish the connection to NOAA’s database, all of the following issues must be satisfied: 

1) The remote station data logger and associated GOES transmitter must be installed and operating. 

2) The user must know the format of the data transmitted through the GOES transmitter. There are 

currently four supported formats: BLM, Time Ordered, Water Surveys Canada, and pseudo-binary. 

3) The GOES Telemetry communication method must be properly configured within the StreamTrac 

Application. 

4) The user must have an account and password issued to them by NOAA. 

When adding or modifying a GOESTelem Communication method, the LRGS Communication Setup “Descriptive 

Name” screen for the identified station will be displayed.   

 
Figure 9-12:  Goes Telemetry Communication Setup screen  

The header bar has fields common to all the Data Format Types.  Each of the four supported Data Format Types 

(BLM, Time Ordered, Water Survey Canada, and Pseudo-Binary) will display its unique choices and buttons for 

formatting the incoming data with its specific parameters. 

 

The Common Header Fields will be explained, followed by detailed explanations of the four Data Format Type 

screens. 

Four Data Format Types 
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9.2.1 Common Header Fields 

NESDIS ID:  The NESDIS ID field is the unique identifier for the remote site’s GOES transmitter.  The identifier is 

an 8 character identifier supplied by NESDIS (National Environmental Satellite Data Information Service) for 

a GOES transmitter at a specific remote monitoring site.  

Data Format Type:   This box specifies which format to use to interpret the incoming data. The four supported 

types are BLM, Time Ordered, Water Surveys Canada, and pseudo-binary.  Each selected Data Format Type 

will display its unique choices and buttons for formatting the incoming data with its specific parameters. 

First Tx:  The First Tx field is an optional field where the user may enter when the first GOES transmission from 

the remote site is scheduled to occur.  This field is for user reference only and does not need to be 

populated in order to receive station data via the LRGS connection (i.e., 00:15:30 would indicate that the first 

GOES transmission would occur at 15 minutes 30 seconds after midnight UTC time). 

Interval:  The Interval field is an optional field in which the user may enter how often the GOES transmission 

occurs.  It should be populated in hh:mm:ss format (i.e., 01:00:00 is hourly).  This field is for user reference 

only and does not need to be populated in order to receive station data via the LRGS connection. 

Baud Rate:  The Baud Rate field is another optional field where the user may enter the Baud Rate of the remote 

sites transmission (i.e., 100 bps, 300 bps, or 1200 bps).  Again, this field is for user reference only and does 

not need to be populated in order to receive station data via the LRGS connection. 

Global Settings:  Click the Global Settings button to open the LRGS Global Settings window.  The settings in this 

window identify the particulars of the LRGS servers at the GOES ground station from which the data will be 

retrieved.  Data will always be collected from the primary server.  In the event that StreamTrac cannot 

connect to the primary server, StreamTrac will attempt to collect data from the secondary server. 

 

Figure 9-13:  Assigning LRGS Servers 

 User ID:  The User ID for the user’s LRGS server account should be entered in this field. 

 Password:  The Password for the user’s LRGS server account should be entered in this field as well as in  

 the Re-enter Password field.  

 IP Address:  The IP Address of the LRGS server should be entered in this field. 

 Port:  The Port Number of the LRGS server should be entered in this field. 
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9.2.2 BLM Format 

The screen below is an example of a typical LRGS Communication Setup window for BLM format.  An 

explanation of the fields follows.  

 
Figure 9-14:  BLM Message Format Setup 

Available Database Fields:  This lists the Fields from which the Selected Ordered Message Fields can be 

created.  Move the desired database fields between columns by clicking on it, and using the left and right 

arrows to toggle between the two columns.  Selecting All moves every available database field to the right 

hand column.  Selecting None, moves all the selected ordered message fields back to the available database 

fields column.   

The Available Database Field list box shows the data fields available in the station.  Upon initial station Setup 

this list is blank and must be populated from the template file or by individually adding station field names 

in the Station> Station Setup>Description tab>Add Field. 

Selected Ordered Message Fields:  The Selected Ordered Message Fields list box displays the selected order of 

the sensor data fields as they will be received from the LRGS database.  The Right Arrow, Left Arrow, All, and 

None buttons can be used to create the properly sequenced data fields under the Selected Ordered 

Message Fields list box from the data fields under the Available Database Field list box. 

Save Data On The Hour:  The Save Data On The Hour checkbox allows the user to save the data retrieved from 

the LRGS database as top of the hour data instead of saving the data with the time of the GOES 

transmission.  Please contact FTS Technical support if you have any questions regarding your specific 

Admin.  

Transposed:  Select this if you desire to receive data in the transposed format (see Section 9.2.2.1). 

 

Sample Data:  When ticked, this box will overlay the actual data from the station alongside the fields’ names 

that you have chosen to aid you in choosing the correct fields mappings. The data is overlaid in lighter gray 

alongside the field names.  

View Raw Data:  This button will allow you to view a sample of the raw data that is returned by the station with 

the chosen NESDISID.  This aids in properly mapping the incoming data to the station’s fields. 
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Add Field:  This button will allow you to add a field to the station without having to open the Station Setup 

Screen. Instead, simply click this button, choose a valid name and click ok. The new field will appear as the 

next item in the selected fields (right side) box. 

Setup from Template 

 

Clicking the Setup From Template button displays a series of common predefined formats containing specific 

database fields.  You can also create your own template and place in the folder if desired. 

 
Figure 9-15:  Open Template screen 

To view the database fields contained in a template, right click on it then select Open.  The template type will be 

identified (BLM) followed by the fields which make it up. 

 

                

Figure 9-16:  BLM Database Fields 

The template fields will be transferred into the Selected Ordered Message Fields column.  
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Figure 9-17: Selected Ordered Message Fields populated with CDNFw2.ini template fields 

To minimize set-up time you can choose a template that is close to your format and tailor it to your need by 

adding and removing fields.  

 

 Regular vs Transposed BLM Message Format 9.2.2.1

BLM messages can be received in either the regular or the transposed format.  In the regular format, the data is 

located in columns, each column headed by the time with the data located vertically beneath the relevant time:  

 

Regular BLM message format: 
 

9A70232A15244145622G44-0NN158WUB00075 
04.52  04.52  04.52 
000 000 000 
095  095 095 
027 027 027 
032 032     032 
089     089     089 
12.8    12.8    12.8 
000.0   000.0   000.0 
074     074     074 
002     002     002 
00001  00001   00001 

 

In transposed format, the data is organized in lines, with each line initiated by the time with the data located 

horizontally: 

 

Transposed BLM message format: 
 

9A70232A15244135622G44-0NN158WUP00075 
                 04.52  000  095  027  032  089  12.8  000.0  074  002  00001 
                 04.52  000  095  027  032  089  12.8  000.0  074  002  00001 

   04.52  000  095  027  032  089  12.8  000.0  074  002 
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9.2.3 Time Ordered Format 

The screen shown below is an example of a typical LRGS Communication Setup window using Time Ordered 

format.   An explanation of the fields follows      

 

 

Figure 9-18:  Time Ordered Message Format 

Sensor Sets:  Sensor Sets allow the transmission of several different sets of data, each set requiring individual 

definitions for the incoming data.  More than one Sensor Set can be defined and will appear in the Set# 

drop down menu, and the same database field may appear in more than one sensor set. 

To create a sensor set click Add Sensor Set, and fill in an identifying numeral when prompted.  The sensor 

set is defined by adding the desired database fields from the Available Database Fields column to the 

Selected Ordered Message Fields column by using the left and right toggle arrows.  Any previously 

defined sensor sets can be edited by selecting them from the drop down menu, and toggling the database 

fields between the two columns.   

 

 
Figure 9-19:  Defining a Sensor Set 
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Sample Data:  When ticked, this box will overlay the actual data from the station alongside the chosen fields’ 

names to aid in choosing the correct fields mappings. The data is overlaid in lighter gray alongside the field 

names.  

The Sensor set number is the first number on each line of the raw incoming data. 

 

Add SDI Address:  Select this to add the fields from an SDI sensor whose fields do not appear in the Available 

Database Fields column. 

 

Add Field:  This button will allow you to add a field to the station without having to open the Station Setup 

Screen. Instead, simply click this button, choose a valid name and click ok. The new field will appear as the 

next item in the selected fields (right side) box. 

 

Setup From Template:  Clicking the Setup From Template button displays a series of common predefined 

formats containing specific database fields.   

Selecting the template is done in the same manner as for BLM formats (see previous section).  Ensure any 

template you select is identified as a Time Ordered Format. 
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9.2.4 Water Surveys Canada Format 

The screen shown below is an example of a typical LRGS Communication Setup window using Time Ordered 

format.  

 An explanation of the fields follows      

 

 

Figure 9-20:  Water Surveys Canada Format 

Shef Code:  Data will be displayed in Standard Hydrometeorological Exchange Format (Shef) Code.   

Clear:  Clicking on Clear will delete all the Shef Codes 

Sample Data:  When ticked, this box will overlay the actual data from the station alongside the fields’ names 

that you have chosen to aid you in choosing the correct fields mappings. The data is overlaid in lighter gray 

alongside the field names.  

View Raw Data:  This button will allow you to view a sample of the raw data that is returned by the station with 

the chosen NESDIS ID.  This aids in properly mapping the incoming data to the station’s fields. 
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9.2.5 Pseudo-Binary 

The screen shown below is an example of a typical LRGS Communication Setup window using Pseudo Binary 

format.  There are two formats of Pseudo Binary that can be selected using the Format button: FTS and 

Environment Canada.  

 
Figure 9-21: LRGS Communication Setup – FTS Pseudo-Binary Format 

 

FTS Pseudo Binary Format:  This format is modeled from the standard NOAA 3 byte Pseudo-binary format.  It is 

a bit packed modified ASCII transmission format. 

Environment Canada Pseudo Binary Format:  This format uses a 3 byte Pseudo binary format on top of or, 

encoding a two byte Campbell Scientific format (see Campbell CR1 10x manual).  All data-time information 

is encoded into the packet and automatically interpreted by StreamTrac without referencing the GOES 

header Date-Time stamp. 

 CREATING DATA SETS 

Pseudo Binary messages are configured by defining data sets. A data set is a group of data points transmitted in 

a defined ordered. Multiple data sets can be defined for Pseudo Binary transmission.   Each data set transmission 

includes the Data Set’s ID number followed by the defined data.  

Data Sets allow the transmission of several different sets of data, each set requiring individual definitions for the 

incoming data.  More than one Data Set can be defined and will appear in the Data Set# drop down menu, and 

the same database field may appear in more than one data set. 

To create a data set click Add Data Set, and fill in an identifying number when prompted.  The data set is 

defined by adding the desired fields from the Available Fields column to the Selected Ordered Fields column 
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by using the left and right toggle arrows.  Any previously defined Data Sets can be edited by selecting them 

from the drop down menu, and toggling the database fields between the two columns.   

 

When adding a Field, a Set Precision (decimal accuracy) prompt will appear.  The Min and Max Values that will be 

able to be sent via pseudo-binary are indicated below the Precision and will change as the precision changes 

(see figure 9-22).  Ensure that your expected values will fall between those Min Max parameters after you set the 

precision.  Precision can be edited by selecting (highlighting) the desired field, and pressing the Precision 

button.  
 

           
Figure 9-22:  Illustrating change in Min/Max values with Precision change 

Data will be transmitted in the order it appears in the Selected Ordered Field column.  This order can be 

adjusted by clicking on a specific field and using the Up and Down buttons to move it within the column. 

To delete a data set, select it in the Data Set drop down menu, then select Delete Data Set.  A prompt will appear 

verifying if you wish to delete it.   

Add Field:  This button will allow you to add a field to the station without having to open the Station Setup 

Screen. Instead, simply click this button, choose a valid name and click ok. The new field will appear as the 

next item in the selected fields (right side) box 
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9.3 COMMUNICATION TYPE – GSNET TELEMETRY 

GSNet Telemetry is only applicable to those systems using FTS Globalstar Satellite modems (FTS models: GS-

4000, Globalstar, or Globalstar-QD) as the telemetry device at the remote stations.  GSNet Telemetry allows users 

to retrieve their station’s data through an Internet connection (Globalstar Direct Internet mode) instead of a 

telephone connection (Globalstar Asynchronous mode).   

Direct Internet mode’s main advantage over the standard asynchronous telephone modem connection is that 

Globalstar satellite constellation ‘gaps’ are effectively eliminated as the SMS message is only delivered when 

satellite signal is available.  There are also cost advantages when using Direct Internet mode because of how 

Globalstar bills for airtime usage – essentially data requests (SMS messages) are free and the user only pays for 

the Internet reply. 

Globalstar Direct Internet mode works as follows: 

1) Data is retrieved using the GSNet Telemetry module (FTS GSNet service is required) to send 

a coded SMS e-mail message addressed to the remote modem instead of using a 

conventional telephone modem to achieve the connection to the remote site. 

2) The e-mailed message is processed by the Globalstar SMS server which delivers the 

message when a satellite signal path is available to the remote modem.  If the message 

cannot be immediately delivered, the SMS server periodically tries to resend the message 

until it is successfully delivered to the remote modem. 

3) When there is satellite coverage and the SMS message is delivered to the remote FTS 

Globalstar Satellite modem, the FTS modem decodes the received SMS message. 

4) The FTS Globalstar Satellite modem then collects the requested information from the 

connected data logger and prepares the data for transmission back to the GSNet Telemetry 

module. 

Note that up to this step no Globalstar airtime charges have been incurred.  Globalstar does not 

charge airtime for delivering an SMS message. 

5) Once the data is ready to be transmitted, the FTS Globalstar Satellite modem creates a 

connection to the Internet through the Globalstar gateway.  Airtime charges are now being 

incurred. 

6) Once the Internet connection is established, the FTS Globalstar Satellite modem sends the 

requested data over the Internet to the StreamTrac GSNet Telemetry module. 

7) After all the data has been successfully transmitted, the Internet connection is terminated.  

Airtime charges stop being accrued on termination of the internet connection. 

8) The call is completed. 
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Figure 9-23: GSNet Communication Setup  

STATION INFORMATION FIELDS  

Description:  The descriptive name assigned at the time this communication method was created.  If you are 

setting up a new method, a dialog box will appear to prompt you to enter a description.   

Area Code and Telephone Number:  Enter the numbers for the remote site’s modem using only numerals (no 

other characters or spaces are valid). 

Password:  If a password has been set in the logger, the password must be entered here.   

Data Overlap:  The purpose of the Data Overlap field is to compensate for the time it may take to deliver a 

Globalstar SMS message to the remote site when satellite service is not available.  In order to avoid possible 

data gaps in the station’s database, the value set in the Data Overlap field should be greater than the value 

set in the GSNet Host Service Max. Wait for Server field 

GSNET HOST SERVICE INFORMATION FIELDS 

Use Global GSNet Host:  Select this when a GSNet Host Service has been defined using the Edit Global Settings 

function. 

Use GSNet Host Settings Below:  Select this when the GSNet service for the remote station has been defined 

locally. 

For both a Globally and a Locally defined GSNet Host, the IP Address, Port Number and working folder for 

the computer running the GSNet Host service must be entered. 

 

IMPORTANT:  A user must have read and write access rights to the Working Folder 

Max Wait for Server:  This is the maximum time StreamTrac will wait for a reply to an SMS data request.  Once 

this time is exceeded the call will be deemed to have failed.  See Data Overlap (above). 
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9.4 COMMUNICATION TYPE - UBICOM 

Ubicom telemetry only applies to those stations using FTS Ubicom.  Ubicom is a dual mode communication 
system which uses either Iridium satellite or terrestrial cellular communications networks to exchange 
information and data between a remote station and the AutoCaller Database. 
 

 
Figure 9-24:  Ubicom Communication Setup 

UbiComID:  Every Ubicom has an FTS assigned ID which is provided with your unit.  Input the assigned ID 
number here. 

 
UbiCom Password:  When the unit is setup a password is provided by FTS.  It must be entered here. 
 
Datalogger/Device:  Use the drop down menu to select the Datalogger model to which the Ubicom will be 

attached. 

 

Registry URL:  Fill in the registry URL here.  If unsure, this can be provided by FTS Service. 

 

Method:  Select the primary transmission method Ubicom will be using.   

 

Auto:  This feature is only functional when operating on the Auto-Switching Gateway.  It permits 

communication with the Ubicom as it automatically switches between Iridium and cellular or when the 

Ubicom’s communication method is switched using Panorama.   

 

NOTE:  If the Auto-Switching Gateway is not being used, and if the Ubicom method is 

switched using Panorama, it must also be switched here in order to maintain Ubicom 

connectivity. 

 

Telem Service IP:  Enter the IP address of your service. 

 

Telem Service Port:  Enter the number of the FTS telemetry service port.   

 

Accept Push Data:  When selected, in addition to requested data, this feature will permit all data to be pushed.  

It is no longer necessary to request the data. 
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CHAPTER 10 TROUBLESHOOTING GUIDE 

 

10.1 TROUBLESHOOTING 

If you get an error message trying to contact a station check the following:  

No station selected. A station or group must be selected.  

No communication method selected. A communication method must be selected.  

Communication method was set up wrong: 

o Telephone Modem:  

 Do you have the right COM port selected? If you don't know which COM port 

your modem uses, ask your system administrator.  

 Are you using the right baud rate? Correct model of modem?  

 Double-check the station's phone number.  

 Make sure you have a standard RJ34-terminated phone line running from the 

modem you are using to an operational wall jack.  

 Do you have to dial a prefix to access an outside line? If so, this can be set up 

by adjusting the Computer Defaults. Click on the Edit Defaults button in the 

communication method setup screen to enter a prefix that will be dialed 

before calling the station. From this menu you can also adjust the telephone 

modem's COM port setting. 

 If you've checked all these settings with no success, then you may want to 

consider checking the station itself, to make sure it is still operational. 

o Radio Modem:  

 Check that the hex address is correct (Note: The address for our Radio modems 

is the four-digit serial number found on the side or bottom of the modem).  

 Try resetting the radio modem, and double check that you have the correct 

model of radio modem listed. 

 Note: To modify your communication settings, open the Stations menu from 

the main menu bar and select Station Setup. From the Station Setup dialog, 

click on the Communication tab to access communication method settings. 

Double-click on a method to open its properties. 

o GS Net: Please consult the GS Net manual. 



StreamTrac  

700-ST-MAN  Rev. 2 -  29 Oct 2015  Page 155/155 

DOCUMENT REVISION HISTORY 

Revision Date Description 

   

1 05 Oct 2015 

Original release.  Incorporated 700-StreamTrac Help Rev 1 

contents.  Updated to AS ver 4.0 (Ubicom push, transposed  GOES 

BLM message format, NFDRS calculation,  Ubicom 

(communication method). 

   
2 29 Oct 2015 

Added Get/Set Data by Tag (Section 2.3.11).  Corrected 
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